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capiTuLO 1

Introducao

QGIS Server is an open source WMS, WES, OGC API for Features 1.0 (WFS3) and WCS implementation that, in
addition, implements advanced cartographic features for thematic mapping. QGIS Server is a FastCGI/CGI (Com-
mon Gateway Interface) application written in C++ that works together with a web server (e.g., Apache, Nginx). It
has Python plugin support allowing for fast and efficient development and deployment of new features.

QGIS Server uses QGIS as back end for the GIS logic and for map rendering. Furthermore, the Qt library is used for
graphics and for platform-independent C++ programming. In contrast to other WMS software, the QGIS Server uses
cartographic rules as a configuration language, both for the server configuration and for the user-defined cartographic
rules.

Como o desktop QGIS e o Servidor QGIS usam as mesmas bibliotecas de visualizacdo, os mapas que sdo publicados
na web t€m a mesma aparéncia do desktop GIS.

In the following sections, we will provide a sample configuration to set up a QGIS Server on Linux (Debian, Ubuntu
and derivatives) and on Windows. For more information about server plugin development, please read server_plugins.

E concedida a permissdo para copiar, distribuir e / ou modificar este documento sob os termos da Licenca de Doc-
umentagdo Livre GNU, Versdo 1.3 ou qualquer versdo posterior publicada pela Fundagido de Software Livre; sem
Secgdes Invariantes, sem textos de Capa e sem contracapa.

A copia da licencga € incluida na secgéo gnu_fdl.
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CAPITULO 2

Iniciando

2.1 Installation on Debian-based systems

We will give a short and simple installation how-to for a minimal working configuration on Debian based systems
(including Ubuntu and derivatives). However, many other distributions and OSs provide packages for QGIS Server.

Nota: No Ubuntu, vocé pode usar seu usudrio comum, acrescentando sudo aos comandos que requerem permissoes
de administrador. No Debian vocé pode trabalhar como administrador (root), sem usar sudo.

Requirements and steps to add official QGIS repositories to install QGIS Server on a Debian based system are provided
in QGIS installers page. You may want to install at least the latest Long Term Release.

Uma vez configurado o repositdrio da versdo desejada e instalado o QGIS Server, vocé pode testar a instalagdo com:

[/usr/lib/cgi—bin/qgis_mapserv.fcgi

)

Se vocé obtiver a seguinte saida, o servidor estd corretamente instalado.

Nota: Dependendo da versiao do QGIS, vocé podera ver uma saida ligeiramente diferente informada quando executar

qgis_mapserv.fcgi'.

Warning 1: Unable
Warning 1: Unable
Warning 1: Unable
—variable.

Warning 1: Unable
Warning 1: Unable
—variable.

QFSFileEngine: :open:

to
to
to

to
to

Content-Length: 206
Content-Type: text/xml;

No file name specified

find driver
find driver
find driver

find driver
find driver

ECW to
ECW to
JP2ECW

ECW to
JP2ECW

charset=utf-8

unload from GDAL_SKIP environment variable.
unload from GDAL_SKIP environment variable.
to unload from GDAL_SKIP environment.

unload from GDAL_SKIP environment variable.
to unload from GDAL_SKIP environment.

<ServiceExceptionReport version="1.3.0" xmlns="https://www.opengis.net/ogc">
<ServiceException code="Service configuration error">Service unknown or.
—unsupported</ServiceException>

</ServiceExceptionReport>



https://qgis.org/resources/installation-guide/#linux
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Nota: Como visto abaixo, o QGIS informa um cédigo de Status 400, que identifica corretamente que a solicitacdo

falhou porque ndo hd sessdo http ativa. Isto ndo € um bug e indica que o servidor estd funcionando corretamente.

Application path not initialized
Application path not initialized

Warning 1: Unable to find driver ECW to unload from GDAL_SKIP environment variable.
Warning 1: Unable to find driver ECW to unload from GDAL_SKIP environment variable.

Warning 1: Unable to find driver JP2ECW to unload from GDAL_SKIP environment.
—variable.

"Loading native module /usr/lib/gqgis/server/libdummy.so"

"Loading native module /usr/lib/qgis/server/liblandingpage.so"

"Loading native module /usr/lib/qgis/server/libwcs.so"

"Loading native module /usr/lib/qgis/server/libwfs.so"

"Loading native module /usr/lib/ggis/server/libwfs3.so"

"Loading native module /usr/lib/qgis/server/libwms.so"

"Loading native module /usr/lib/qgis/server/libwmts.so"

QFSFileEngine::open: No file name specified

Content-Length: 102

Content-Type: application/json

Server: QGIS FCGI server - QGIS version 3.40.0-Bratislava

Status: 400

[{"code":"Bad request error","description":"Requested URI does not match any.
—registered API handler"}]

Let’s add a sample project. You can use your own, or one from Training demo data:

mkdir /home/qgis/projects/

cd /home/ggis/projects/

wget https://github.com/qgis/QGIS-Training-Data/archive/release_3.40.zip

unzip release_3.40.zip

mv QGIS-Training-Data-release_3.40/exercise_data/qggis—-server—-tutorial-data/world.
—dgs

mv QGIS-Training-Data-release_3.40/exercise_data/qgis—-server—-tutorial-data/
—naturalearth.sqglite

J

Certamente, voc€ pode usar seu software GIS favorito para abrir este arquivo e dar uma olhada na configuracdo e nas

camadas disponiveis.

Para implantar corretamente o servidor QGIS, vocé precisa de um servidor HTTP. As escolhas recomendadas sdo

Apache ou NGINX.

2.1.1 Servidor HTTP Apache

Nota: In the following, please replace ggis . demo with the name or IP address of your server.

1. Instalar Apache e mod_fcgid:

[apt install apache2 libapache2-mod-fcgid

J

2. Voceé pode executar o QGIS Server em seu site padrdo, mas vamos configurar um virtual host especificamente

para isto, como segue.

1. No diretdrio :file: /etc/apache2/sites-available’, crie um arquivo chamado :arquivo:” qgis.demo.conf’, com

este conteudo:

<VirtualHost *:80>
ServerAdmin webmaster@localhost

(continua na préxima pagina)
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(continuac@o da pégina anterior)

ServerName ggis.demo
DocumentRoot /var/www/html

# Apache logs (different than QGIS Server log)
ErrorLog ${APACHE_LOG_DIR}/ggis.demo.error.log
CustomLog ${APACHE_LOG_DIR}/qggis.demo.access.log combined

# Longer timeout for WPS... default = 40
FcgidIOTimeout 120

FcgidInitialEnv LC_ALL "en_US.UTF-8"
FcgidInitialEnv PYTHONIOENCODING UTF-8
FcgidInitialEnv LANG "en_US.UTF-8"

# OGIS log
FcgidInitialEnv QGIS_SERVER_LOG_STDERR 1
FcgidInitialEnv QGIS_SERVER_LOG_LEVEL 0

# default QGIS project
SetEnv QGIS_PROJECT_FILE /home/qggis/projects/world.qgs

# QGIS_AUTH_DB_DIR PATH must lead to a directory writeable by the Server
—'s FCGI process user

FcgidInitialEnv QGIS_AUTH_DB_DIR_PATH "/home/ggis/ggisserverdb/"

FcgidInitialEnv QGIS_AUTH_PASSWORD_FILE "/home/ggis/ggisserverdb/ggis—
—auth.db"

# Set pg access via pg_service file
SetEnv PGSERVICEFILE /home/qgis/.pg_service.conf
FcgidInitialEnv PGPASSFILE "/home/qggis/.pgpass"

# 1f ggis—server is installed from packages in debian based distros this.
—1is usually /usr/lib/cgi-bin/
# run "locate qggis_mapserv.fcgi"” if you don't know where ggis_mapserv.
—~fcgl is
ScriptAlias /cgi-bin/ /usr/lib/cgi-bin/
<Directory "/usr/lib/cgi-bin/">
AllowOverride None
Options +ExecCGI -MultiViews -SymLinksIfOwnerMatch
Require all granted
</Directory>

<IfModule mod_fcgid.c>
FcgidMaxRequestLen 26214400
FcgidConnectTimeout 60
</IfModule>

</VirtualHost>

Nota: Algumas das opgdes de configuracdo acima sdo explicadas nas secdes Servidor varidveis de
ambiente e pg_service file

2. Vamos agora criar os diretdrios que irdo armazenar os logs e o banco de dados de autentica¢do do Servidor
QGIS:

mkdir -p /var/log/qgis/
chown www-data:www-data /var/log/qgis
mkdir -p /home/qgis/ggisserverdb

(continua na proxima pagina)
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(continuac@o da pégina anterior)

{chown www—data:www—data /home/ggis/qggisserverdb

Nota: www—-data is the Apache user on Debian based systems and we need Apache to have access
to those locations or files. The chown www-data. .. commands change the owner of the respective
directories and files to www-data.

3. Agora podemos habilitar o host virtual e o0 fcgid mod, se isso ainda ndo tiver sido feito:

azenmod fcgid
azensite ggis.demo

4. Now restart Apache for the new configuration to be taken into account:

[systemctl restart apache?2 }

5. Agora que o Apache sabe que deve responder aos pedidos para http://qgis.demo também precisamos configurar
o sistema do cliente para que ele saiba quem € ggis . demo. Fazemos isso adicionando 127.0.0.1 ggis.
demo no arquivo hosts.

# Replace 127.0.0.1 with the IP of your server.
sh -c¢c "echo '127.0.0.1 ggis.demo' >> /etc/hosts"

Importante: Remember that both the ggis.demo.conf and /etc/hosts files should be configured for your
setup to work. You can also test the access to your QGIS Server from other clients on the network (e.g. Windows or
macos machines) by going to their /etc/hosts file and point the ggis.demo name to whatever IP the server
machine has on the network (not 127.0.0.1 as it is the local IP, only accessible from the local machine). On
*n1ix machines the host s file is located in /et c, while on Windows it’s under the C: \Windows\System32\
drivers\etc directory. Under Windows you need to start your text editor with administrator privileges before
opening the hosts file.

QGIS Server is now available at http://qgis.demo. To check, type in a browser, as in the simple case:

http://ggis.demo/cgi-bin/gqgis_mapserv.fcgi?SERVICE=WMS&VERSION=1.3.0&
—REQUEST=GetCapabilities

2.1.2 Servidor HTTP NGINX

Nota: In the following, please replace ggis . demo with the name or IP address of your server.

You can also use QGIS Server with NGINX. Unlike Apache, NGINX does not automatically spawn FastCGI pro-
cesses. The FastCGI processes are to be started by something else.

Instalar NGINX:

[apt install nginx }

* As a first option, you can use spawn-fcgi or fegiwrap to start and manage the QGIS Server processes. Official
Debian packages exist for both. When you have no X server running and you need, for example, printing, you
can use xvfb.

* Another option is to rely on Systemd, the init system for GNU/Linux that most Linux distributions use today.
One of the advantages of this method is that it requires no other components or processes. It’s meant to be
simple, yet robust and efficient for production deployments.

8 Capitulo 2. Iniciando
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Configuracao NGINX

The include fastcgi_params; used in the previous configuration is important, as it adds the parameters from /etc/

nginx/fastcgi_params:
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fastcgi_param QUERY_ STRING Squery_string;
fastcgi_param REQUEST_METHOD Srequest_method;
fastcgi_param CONTENT_TYPE Scontent_type;
fastcgi_param CONTENT_LENGTH Scontent_length;
fastcgi_param SCRIPT_NAME Sfastcgi_script_name;
fastcgi_param REQUEST_URI Srequest_uri;
fastcgi_param DOCUMENT_URI Sdocument_uri;
fastcgi_param DOCUMENT_ROOT Sdocument_root;
fastcgi_param SERVER_PROTOCOL Sserver_protocol;
fastcgi_param REQUEST_SCHEME Sscheme;
fastcgi_param HTTPS Shttps if_not_empty;
fastcgi_param GATEWAY_INTERFACE CGI/1.1;
fastcgi_param SERVER_SOFTWARE nginx/$nginx_version;
fastcgi_param REMOTE_ADDR Sremote_addr;
fastcgi_param REMOTE_PORT Sremote_port;
fastcgi_param SERVER_ADDR $Sserver_addr;
fastcgi_param SERVER_PORT Sserver_port;
fastcgi_param SERVER_NAME Sserver_name;

# PHP only, required if PHP was built with --enable-force-cgi-redirect
fastcgi_param REDIRECT_STATUS 200;

Moreover, you can use some Varidveis ambientais to configure QGIS Server. In the NGINX configuration file, /
etc/nginx/nginx.conf, you have to use fastcgi_param instruction to define these variables as shown
below:

location /ggisserver {

gzip ;

include fastcgi_params;

fastcgi_param QGIS_SERVER_LOG_STDERR 1;
fastcgi_param QGIS_SERVER_LOG_LEVEL 0;
fastcgi_pass unix:/var/run/qgisserver.socket;

FastCGIl wrappers

Aviso: fcgiwrap is easier to set up than spawn-fcgi, because it’s already wrapped in a Systemd service. But it
also leads to a solution that is much slower than using spawn-fcgi. With fcgiwrap, a new QGIS Server process is
created on each request, meaning that the QGIS Server initialization process, which includes reading and parsing
the QGIS project file, is done on each request. With spawn-fcgi, the QGIS Server process remains alive between
requests, resulting in much better performance. For that reason, spawn-fcgi is recommended for production use.

gerar-fcgi

Se vocé quiser utilizar spawn-fcgi:

1. O primeiro passo € instalar o pacote:

[apt install spawn-fcgi ]

2.1. Installation on Debian-based systems 9
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(¢}

2. Em seguida, introduzir o seguinte bloco na configuracéo do seu servidor NGINX:

location /ggisserver {

gzip ;
include fastcgi_params;
fastcgi_pass unix:/var/run/ggisserver.socket;

3. E reiniciar o NGINX para levar em conta a nova configuragio:

[systemctl restart nginx

J

4. Finally, considering that there is no default service file for spawn-fcgi, you have to manually start QGIS Server
in your terminal:

spawn-fcgi -s /var/run/ggisserver.socket \
-U www—data -G www—-data -n \
/usr/lib/cgi-bin/qgis_mapserv.fcgi

Servidor QGIS estd agora disponivel em http://qgis.demo/qgisserver.

Nota: When using spawn-fcgi, you may directly define environment variables before running the server. For exam-
ple: export QGIS_SERVER_LOG_STDERR=1

E claro, vocé pode adicionar um roteiro de inicializagfo para iniciar o QGIS Server no momento da inicializagdo ou
sempre que quiser. Por exemplo, com systemd:

1. Edite o arquivo:file:/etc/systemd/system/qgis-server.service com este contetido:

[Unit]
Description=QGIS server
After=network.target

[Service]

;; set env var as needed

;Environment="LANG=en_ EN.UTF-8"
;Environment="QGIS_SERVER PARALLEL RENDERING=1"
;Environment="QGIS_SERVER MAX_ THREADS=12"
;Environment="QGIS SERVER LOG_LEVEL=0"
;Environment="QGIS_ SERVER LOG_STDERR=1"

;; or use a file:
;EnvironmentFile=/etc/qgis—server/env

ExecStart=spawn-fcgi -s /var/run/gqgisserver.socket -U www-data -G www-data -n /
—usr/lib/cgi-bin/ggis_mapserv.fcgi

[Install]
WantedBy=multi-user.target

2. Em seguida, habilitar e iniciar o servico:

[systemctl enable --now ggis-server }

Aviso: With the above commands spawn-fcgi spawns only one QGIS Server process.

10
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fcgiwrap

Utilizar fcgiwrap é muito mais facil de configurar do que spawn-fegi mas é muito mais lento.

1. Primeiro vocé precisa instalar o pacote correspondente:

[apt install fcgiwrap

2. Em seguida, introduzir o seguinte bloco na configuracéo do seu servidor NGINX:

1 location /ggisserver {

2 gzip g

3 include fastcgi_params;

4 fastcgi_pass unix:/var/run/fcgiwrap.socket;

s fastcgi_param SCRIPT_FILENAME /usr/lib/cgi-bin/ggis_mapserv.fcgi;

3. Finally, restart NGINX and fegiwrap to take into account the new configuration:

systemctl restart nginx
systemctl restart fcgiwrap

O Servidor QGIS esta agora disponivel em http://qgis.demo/qgisserver.

Sistemad

QGIS Server needs a running X Server to be fully usable, in particular for printing. In the case you already have a

running X Server, you can use systemd services.

Este método, para implantar o Servidor QGIS, conta com duas unidades Systemd para configurar: uma Unidade de

bolso e uma Unidade de servigo.

1. The QGIS Server Socket unit defines and creates a file system socket, used by NGINX to start and com-
municate with QGIS Server. The Socket unit has to be configured with Accept=false, meaning that the
calls to the accept () system call are delegated to the process created by the Service unit. It is located in
/etc/systemd/system/ggis—-server@. socket, which is actually a template:

p
[Unit]
Description=QGIS Server Listen Socket (instance %i)

[Socket]
Accept=false
ListenStream=/var/run/ggis-server-%i.sock
SocketUser=www—-data

SocketGroup=www—-data

SocketMode=0600

[Install]
WantedBy=sockets.target
.

2. Agora ative e inicie as tomadas:

[for iin 1 2 3 4; do systemctl enable --now ggis-server@$i.socket; done

J

3. The QGIS Server Service unit defines and starts the QGIS Server process. The important part is that the
Service process’ standard input is connected to the socket defined by the Socket unit. This has to be configured
using StandardInput=socket inthe Service unit configuration located in /et c/systemd/system/
ggis—-server@.service

2.1. Installation on Debian-based systems 11
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-
[Unit]
Description=QGIS Server Service (instance %i)

[Service]

User=www—-data

Group=www—-data

StandardOutput=null

StandardError=journal

StandardInput=socket
ExecStart=/usr/lib/cgi-bin/ggis_mapserv.fcgi
EnvironmentFile=/etc/qggis—-server/env

[Install]
WantedBy=multi-user.target

Nota: The QGIS Server environment variables are defined in a separate file, /etc/ggis—-server/env.
It could look like this:

QOGIS_PROJECT_FILE=/etc/ggis/myproject.dqgs
QGIS_SERVER_LOG_STDERR=1
QOGIS_SERVER_LOG_LEVEL=3

4. Now start socket service:

[for iin 1 2 3 4; do systemctl enable —--now ggis—-server@S$i.service; done ]

5. Finalmente, para o servidor HTTP NGINX, vamos apresentar a configuragio desta instalagio:

upstream ggis-server_backend {
server unix:/var/run/ggis-server-1.sock;
server unix:/var/run/qgis-server-2.sock;
server unix:/var/run/qgis-server-3.sock;
server unix:/var/run/qgis-server-4.sock;

server {

location /ggis-server {
gzip off;
include fastcgi_params;
fastcgi_pass ggis-server_backend;

}

.

6. Now restart NGINX for the new configuration to be taken into account:

[systemctl restart nginx ]

Thanks to Oslandia for sharing their tutorial.
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2.1.3 Xvfb

QGIS Server needs a running X Server to be fully usable, in particular for printing. On servers it is usually recom-
mended not to install it, so you may use xv£b to have a virtual X environment.

If you're running the Server in graphic/X11 environment then there is no need to install xvfb. More info at https:
/Iwww.itopen.it/qgis-server-setup-notes/.

1. Para instalar o pacote:

[apt install xvfb }

2. Create the service file, /etc/systemd/system/xvfb.service, with this content:

-
[Unit]

Description=X Virtual Frame Buffer Service
After=network.target

[Service]

ExecStart=/usr/bin/Xvfb :99 -screen 0 1024x768x24 —-ac +extension GLX +render -
—noreset

[Install]
WantedBy=multi-user.target

L

3. Ative, inicie e verifique o status do xvfb.service:

systemctl enable —--now xvfb.service
systemctl status xvfb.service

4. Then, according to your HTTP server, you should configure the DISPLAY parameter or directly use xvfb-run.
» Usando Apache:

1. Adicione a sua configuracdo Fcgid (ver Servidor HT'TP Apache):

[chidlnitialEnv DISPLAY ":o9" }

2. Reinicie o Apache para que a nova configuracio seja considerada:

[systemctl restart apache?2 J

e Usando NGINX

— With spawn-fcgi using xvfb-run:

xvfb-run /usr/bin/spawn-fcgi —-f /usr/lib/cgi-bin/qgis_mapserv.fcgi \
-s /tmp/qggisserver.socket \
-G www—data -U www-data -n

— With the DISPLAY environment variable in the HTTP server configuration.

[fastcgi_param DISPLAY T299ue }

2.1. Installation on Debian-based systems 13
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2.2 Instalacao no Windows

QGIS Server can also be installed on Windows systems using the OSGeo4W network installer (https://qgis.org/

resources/installation-guide/#windows).
Um procedimento simples € o seguinte:

1. Baixe e execute o instalador OSGeo4W

2. Siga a “Instalacido Avancgada” e instale os pacotes QGIS Desktop, QGIS Server apache e mod_fcgid.

&} 05GeodW Setup - Select Packages

Select Packages
Select packages to install

— O

pe
e
L%

€

Hide obsolete packages

Search | | Clear OKeep OPrev@Cur (O Ep View | Category
Categary Cument Mew Bin? Src? Package
B Al £ Defautt

Commandine_Ltilities 4% Default

Desktop 4¥ Default

Libs &% Default

B Web &* Default
¥ 24521 O 7520k apache: Apache Webserver
& 231041 O 33 mod_fcgid: Apache FastCGl ASF module
& Skip nja nja 2,308k qggigdtr-server: QGIS Server long tem release)
4¥3241-2 O 1,294k ggis-server: QGIS Server
&¥ Skip nja nja 19,023 gwec-services: QWC services
& Skip nja nja 3066k gwcZ QGIS webclient 2

< Précédent Annuler

3. O Apache nio € instalado diretamente como um servico no Windows. Vocé precisa fazé-lo:

1. Right-click the 0SGeo4W.bat file at the root of the C: \0SGeo4W\ folder (if the default installation

paths have been used) and select Run as administrator

2. No console, execute apache—install.bat, que terd saida

> apache-install.bat

Installing the 'Apache 0SGeo4W Web Server'
The 'Apache 0SGeo4W Web Server'

Testing httpd.conf....

service
service is successfully installed.

Errors reported here must be corrected before the service can be started.

O servigo esta iniciado, como vocé pode notar no relatério. Mas o servidor pode néo funcionar devido a

falta de configuracdo personalizada.

4. Edit the C:\0OSGeo4w\apps\apache\conf\httpd.conf file with the following changes (various

other combinations are possible):

14
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Finalidade Configuracao existente Substituicao

(Opcional) Personalize o en-

derego para ouvir usando um IP  1isten ${SRVPORT} Listen localhost:8080
e/ou porta, Voc€ pode e adicionar

quantas entradas desejar.

Indique onde encontrar os ar-

quivos de script ScriptAlias /cgi-bin/ "$ |ScriptAlias /cgi-bin/
—{SRVROOT}/cgi-bin/" —"C:/0SGeodW/apps/qgis/
<—>bln/ "

Fornecer permissdes na pasta de

SCfiPtS <Directory "${SRVROOT}/ <Directory "C:/0SGeodW/
—cgi-bin"> —apps/qggis/bin">
AllowOverride None SetHandler cgi-
Options None —script
Require all granted AllowOverride None
</Directory> Options ExecCGI
Require all granted
</Directory>

Habilitar extensdes de arquivo

para uso em arquivos de script.  #addHandler cgi-script . AddHandler cgi-script
Descomentar e completar wcgi ~cgi .exe

Adicionar mais varidveis de

configura¢ao personalizadas 4 parse 0SGeo4w apache. # parse 0SGeo4W apache.
0SGeodW —conf files —conf files
IncludeOptional "C:/ IncludeOptional "C:/
—0SGeo4W/httpd.d/httpd_ —0SGeodW/httpd.d/httpd_
—*.conf" —*.conf"
SetEnv GDAL_DATA "C:/
—0SGeodW/share/gdal"

SetEnv QGIS_AUTH_DB_DIR_
—PATH "C:/0SGeod4W/apps/
—ggis/resources"

5. Reiniciar o servidor web Apache

[> apache-restart.bat

6. Abra a janela do navegador para testar uma solicitacdo de GetCapabilities no Servidor QGIS. Substitua 10—
calhost:8080 pelo IP e porta que vocé definir para ouvir.

http://localhost:8080/cgi-bin/ggis_mapserv.fcgi.exe?SERVICE=WMS&VERSION=1.3.0&
—REQUEST=GetCapabilities

Um :arquivo:" XML arquivo com as capacidades deve ser devolvido. Seu servidor esta pronto para uso.
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2.3 Serve a project

Agora que o Servidor QGIS estd instalado e funcionando, s6 temos que usa-lo.

Obviously, we need a QGIS project to work on. Of course, you can fully customize your project by defining contact
information, precise some restrictions on CRS or even exclude some layers. Everything you need to know about that
is described later in Configurar seu projeto.

But for now, we are going to use a simple project already configured and previously downloaded in /home /qgis/
projects/world.qgs, as described above.

Ao abrir o projeto e dar uma olhada rdpida nas camadas, sabemos que 4 camadas estdo disponiveis no momento:
* aeroportos
* lugares
* paises
e countries_shapeburst

Vocé ndo precisa entender a solicitacdo completa por enquanto, mas pode recuperar um mapa com algumas das
camadas anteriores gracas ao Servidor QGIS fazendo algo assim em seu navegador da web para recuperar a camada
paises:

« If you followed the above instructions to install an Apache HTTP Server:

http://ggis.demo/cgi-bin/qgis_mapserv.fcgi?MAP=/home/qgis/projects/world.qgsé&
—LAYERS=countries&SERVICE=WMS&VERSION=1.3.0&REQUEST=GetMap&CRS=EPSG:4326&
—WIDTH=400&HEIGHT=200&BBOX=-90,-180, 90, 180

* If you followed the above instructions to install an NGINX HTTP Server:

http://qgis.demo/qgisserver?MAP=/home/qggis/projects/world.ggs&LAYERS=countriesé&
—SERVICE=WMS&VERSION=1.3.0&REQUEST=GetMap&CRS=EPSG:4326&WIDTH=400&HEIGHT=200&
—BBOX=-90,-180, 90,180

Se vocé obtiver a proxima imagem, entdo o Servidor QGIS estd rodando corretamente:

Figura2.1: Server response to a basic GetMap request

Note that you may define QGIS_PROJECT_FILE environment variable to use a project by default instead of giving
a MAP parameter (see Varidveis ambientais).

Por exemplo com spawn-fcgi:
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export QOGIS_PROJECT_FILE=/home/qgis/projects/world.qgs
spawn-fcgi —-f /usr/lib/bin/cgi-bin/qgis_mapserv.fcgi \
-s /var/run/qgisserver.socket \
-U www—data -G www—data -n

2.4 Configurar seu projeto

To provide a new QGIS Server WMS, WES, OAPIF or WCS, you have to create a QGIS project file with some data
or use one of your current project. Define the colors and styles of the layers in QGIS and the project CRS, if not
already defined. Then, go to the QGIS Server menu of the Project » Properties... dialog and provide some information
about the OWS in the Service Capabilities tab.
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Project Properties — QGIS Server X
Services Capabilities | WMS = WMTS WFS/OAPIF =~ WCS 3
\'--..__ General v |v| Enable Service Capabilities
a Metadata These parameters are used to generate the GetCapabilities document and shall be
chosen carefully to avoid interoperability and security issues.
View Settings Y P by =
Short name A name used to identify the root layer. The short name is a text ...
Title The title should be brief yet descriptive enough to identify this ...
#2 Transformations _
Organization The name of the service provider.
=/
e e Online resource  |The web site URL of the service provider. =i
B8 Data Sources Person The contact person name for the service.
EE Relations Position -
Variables E-Mail The contact person e-mail for the service.
@ Phone The contact person phone for the service.
s Macros
=
= " QGIS Server
Abstract
Fees Conditions Unknown -
Access constraints |[None v
Keyword list List of keywords separated by comma to help catalog searching.
Tesk Configuration
Launch
©Help @apply || @cancel

Figura2.2: Definitions for a QGIS Server WMS/WFES/WCS project

You have to Enable Service Capabilities first, if it is deactivated. This will appear in the GetCapabilities response of

the WMS, WFS or WCS. If you don’t check o Enable Service capabilities, QGIS Server will use the information
given in the wms_metadata.xml file located in the cgi-bin folder.
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2.4.1 Recursos WMS

Project Properties — QGIS Server
Services Capabilities | WMS | WMTS = WFS/OAPIF | WCS

\'..__ General w V| Advertised extent

& Metadata -6413275.3590,6751261.3334,2496221.8705,7575689.2244 [EPS5G:2964] B [~
[8# view settings » |¥| CRS restrictions

> Exclude layouts b Exclude layers
f',! Transformations > INSPIRE (European directive)
w Layer and Feature options

Use layer ids as names

Use attribute form settings for GetFeatureInfo response
==}
B8 Data Sources

Add geometry to feature response
g Relations Segmentize feature info geometry
variables GetFeatureInfo geometry precision (decimal places) 8 -

@ Macros Advertised URL
() =

!-‘- QGIS Server w Map and Legend Options

a Temporal Add layer groups in GetlLegendGraphic

Skip name attribute for groups

=I Elevation

Maximum image size for GetMap and GetLegendGraphic requests
Sensors

Width Height

Quality for JPEG and WebP images (from 0 to 100; 0 - smaller size, 100 - better quality) | 90 -

Maximum features for Atlas print requests 1 -
Tile buffer in pixels 0 -
Default scale for legend 1:305 -

Test Configuration

Launch

18 pide + Ok + Appliquer | | © Annuler

Figura2.3: Definitions in the WMS tab

In the WMS tab, you can define the options for the WMS capabilities.

* Check Advertised extent to define the extent advertised in the WMS GetCapabilities response. The spatial
extent selector widget helps you enter the extent as a xmin, xmax, ymin, ymax textor pick it from the
map canvas, layers, bookmarks. ..

* By checking A CRS restrictions, you can restrict in which coordinate reference systems (CRS) QGIS Server
will offer to render maps. It is recommended that you restrict the offered CRS as this reduces the size of the

WMS GetCapabilities response. Use the Ifl'l:l-l:| button below to select those CRSs from the Coordinate Reference
System Selector, or click Used to add the CRSs used in the QGIS project to the list.

* If you have print layouts defined in your project, they will be listed in the GetProject Sett ings response,
and they can be used by the GetPrint request to create prints, using one of the print layouts as a template. This
is a QGIS-specific extension to the WMS 1.3.0 specification. If you want to exclude any print layout from

being published by the WMS, check i Exclude layouts and click the HE-:J button below. Then, select a print
layout from the Select print layout dialog in order to add it to the excluded layouts list.
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* If you want to exclude any layer or layer group from being published by the WMS, check i Exclude Layers

and click the Ifl'l}:l button below. This opens the Select restricted layers and groups dialog, which allows you to
choose the layers and groups that you don’t want to be published. Use the Shift or Ctrl key if you want
to select multiple entries. It is recommended that you exclude from publishing the layers that you don’t need
as this reduces the size of the WMS GetCapabilities response which leads to faster loading times on the client

side.

* Layer and Feature Options

You can receive requested GetFeaturelnfo as plain text, XML and GML. The default is XML.

If you check i Use layer ids as name, layer ids will be used to reference layers in the GetCapabil-
ities response or GetMap LAYERS parameter. If not, layer name or short name if defined (see
vectorservermenu) is used.

If you wish, you can check o Add geometry to feature response. This will include the bounding box for
each feature in the GetFeatureInfo response. See also the WITH_GEOMETRY parameter.

As many web clients can’t display circular arcs in geometries you have the option to segmentize the
geometry before sending it to the client in a GetFeatureInfo response. This allows such clients to still

display a feature’s geometry (e.g. for highlighting the feature). You need to check the i Segmentize
feature info geometry to activate the option.

You can also use the GetFeaturelnfo geometry precision option to set the precision of the GetFeaturelnfo
geometry. This enables you to save bandwidth when you don’t need the full precision.

If one of your layers uses the Map Tip display (i.e. to show text using expressions) this will be listed
inside the GetFeaturelnfo output. If the layer uses a Value Map for one of its attributes, this information
will also be shown in the GetFeatureInfo output.

Se vocé quiser que o QGIS Server anuncie URLs de solicita¢do especificas na resposta do WMS GetCa-
pabilities, digite a URL correspondente no campo URL anunciada

e Map and Legend Options

When a layer group is passed to GetLegendGraphic request, all of its leaf layers are added to the

legend picture (however without the groups’ labels). Check the o Add layer groups in GetLegendGraphic
option if you want to also insert the layer groups (and subgroups) names into the layer tree, just like in
QGIS Desktop legend.

When QGIS project contains layer groups, they are listed in WMS capabilities document alongside with
layers. If a group (its name as listed in capabilities) is included in WMS GetMap LAYERS parameter
alongside with names of layers in that group, QGIS would duplicate the layers: once for the group and

once for specific layer. If you check the o Skip name attribute for groups option, GetCapabilities will
only return title attribute for the group but not its name attribute, making it impossible to include groups
in list of layers of GetMap request.

Furthermore, you can restrict the maximum size of the maps returned by the requests by entering the
maximum width and height into the respective fields under Maximum image size for GetMap and GetLe-
gendGraphic requests.

You can change the Quality for JPEG and WebP images factor. The quality factor must be in the range 0
to 100. Specify 0 for maximum compression, 100 for no compression.

You can change the limit for atlas features to be printed in one request by setting the Maximum features
for Atlas print requests field.

When QGIS Server is used in tiled mode (see TILED parameter), you can set the Tile buffer in pixels.
The recommended value is the size of the largest symbol or line width in your QGIS project.

Depending on whether the map uses a projected CRS or a geographic CRS and if there is no information
to evaluate the map unit sized symbols, you can provide reference for size through either a Default scale
for legend or Default map units per mm in legend.

20
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2.4.2 WMTS capabilities

In the WMTS tab you can select the layers you want to publish as WMTS and specify if you want to publish as PNG

or JPEG.
Project Properties — QGIS Server x
Services Capabilities = WMS | WMTS | WFS/OAPIF = WCS
\ General ¥ Published layers
E Metadata Layer = Published PNG JPEG =
~ Project
& view Settings » Water Group
shapefiles — tundra
€5 CcRrs shapefiles — trees
- shapefiles — trails
# Transformations shapef!les—stgragep
: shapefiles — railroads
%" Default styl shapefiles —popp
& Defauitstyles shapefiles — pipelines
shapefiles — landice
E Data Sources shapefiles — grassland
5 lati shapefiles — builtups
g Relations shapefiles — airports
_ csv —elevp
Variables climate
» _Roundaries Groun b’
{G) Macros
= - ¥ Grids
B s QGIS Server
- CRS “ Published Top Left Min. scale Last level
a- Temporal
1 2
Minimum scale 5000 =
Advertised URL
Test Configuration
Launch
©Help @apply || ©cancel

Figura2.4: Definitions in the WMTS tab

If you enter a URL in the Advertised URL field, QGIS Server will advertise this specific URL in the WMTS GetCa-
pabilities response.
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2.4.3 WFS/OAPIF capabilities

In the WFS/OAPIF tab, you can select the layers you want to publish as WFS or OAPIF, and specify if they will allow
update, insert and delete operations.

Project Properties — QGIS Server X
Services Capabilities = WMS = WMTS | WFS/OAPIF | wCS
\'--..__ General The WFS capabilities also influences DXF export
! Metadata . Layer. Published Geometry precision Update Insert
0 shapefiles — airports 8 =
View Settings 1 |shapefiles —alaska 8 =
.5:?’-: CRS 2 shapefiles — builtups 8 -
P 3 climate 8 =
o i 3
e Transformations Bl v — elevp 8 -
% Default styles 5 shapefiles —grassland 8 =
6 shapefiles — lakes 8 =
E Data Sources
- 7 shapefiles — landice 8 -
g Relations 8 | shapefiles — majrivers 8 =
Variables 9 shapefiles — pipelines 8 =
& 10 shapefiles — popp 8 =
¥} Macros
bl 11 shapefiles — railroads 8 =
Q-! QGIS Server 12 shapefiles — regions 8 -
a. L — 13 |shapefiles —rivers 8 =
' 14 shapefiles — storagep 8 =
15 shapefiles — swamp 8 -
16 shapefiles — trails 8 =
17 shapefiles — trees 8 =
18 shapefiles — tundra 8 -
1 2
Publish all Unpublish All
Advertised URL
Teskt Configuration
Launch
@ Help @napply | @cancel

Figura2.5: Definitions in the WES/OAPIF tab

If you enter a URL in the Advertised URL field, QGIS Server will advertise this specific URL in the WFS GetCapa-
bilities response.
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2.4.4 WCS capabilities

In the WCS tab, you can select the layers that you want to publish as WCS.

Project Properties — QGIS Server

Services Capabilities = WMS = WMTS = WFS/OAPIF

N

%, General Layer Published

0/ Bing Map

! Metadata

View Settings
CRS

Transformations

o,

% Default Styles

[= ==}

B8 Data Sources

EE Relations
Variables

{;‘-® Macros

!-! QGIS Server

Select All

Advertised URL

Test Configuration

Launch

©Help

%
WCS
Deselect All
Oaoply | Ocance

Figura2.6: Definitions in the WCS tab

If you enter a URL in the Advertised URL field of the WCS capabilities section, QGIS Server will advertise this specific

URL in the WCS GetCapabilities response.

2.4. Configurar seu projeto
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2.4.5 Sintonia fina do seu OWS

For vector layers, the Fields tab of the Layer » Layer Properties dialog allows you to define for each attribute if it will
be published or not. By default, all the attributes are published by your WMS and WFS. If you don’t want a specific
attribute to be published, uncheck the appropriate checkbox in the Configuration column:

* Do not expose in WFS
* Do not expose in WMS

You can overlay watermarks over the maps produced by your WMS by adding text annotations or SVG annotations
to the project file. See the sec_annotations section for instructions on creating annotations. For annotations to be
displayed as watermarks on the WMS output, the Fixed map position checkbox in the Annotation text dialog must be
unchecked. This can be accessed by double clicking the annotation while one of the annotation tools is active. For
SVG annotations, you will need either to set the project to save absolute paths (in the General menu of the Project »
Properties... dialog) or to manually modify the path to the SVG image so that it represents a valid relative path.

2.5 Integracao com terceiros

QGIS Server provides standard OGC web services like WMS, WES, etc. thus it can be used by a wide variety of end
user tools.

2.5.1 Integracao com o QGIS Desktop

QGIS Desktop is the map designer where QGIS Server is the map server. The maps or QGIS projects will be served
by the QGIS Server to provide OGC standards. These QGIS projects can either be files or entries in a database (by
using Project » Save to » PostgreSOL in QGIS Desktop).

Além disso, deve ser estabelecido um fluxo de trabalho dedicado de atualizagdo para atualizar um projeto utilizado por
um Servidor QGIS (ou seja, copiar arquivos de projeto para a localizagdo do servidor e reiniciar o Servidor QGIS).
Por enquanto, os processos automatizados (como servico de recarga de mensagens do servidor em fila de espera)
ainda ndo estdo implementados.

2.5.2 Integracao com MapProxy

MapProxy is a tile cache server and as it can read and serve any WMS/WMTS map server, it can be directly connected
to QGIS server web services and improve end user experience.

2.5.3 Integracao com QWC2

QWC2 <https://github.com/qgis/qwc2>"_ € uma aplicacdo web responsiva e dedicada ao Servidor QGIS. Ele ajuda
vocé a construir um visualizador de mapas altamente personalizado com sele¢do de camadas, informacdes de car-
acteristicas, etc... Também estdo disponiveis muitos plugins como autentica¢do ou servico de impressdo, a lista
completa estd disponivel neste “repositorio <https://github.com/qwc-services>>"_.
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CAPITULO 3

Servicos

QGIS Server is able to serve data according to standard protocols as described by the Open Geospatial Consortium
(OGCO):

s WMS1.1.1e1.3.0

* WFS1.0.0e1.1.0

¢ OGC API - Features (WFS3)
* WCS1.00e1.1.1

* WMTS 1.0.0

Extra vendor parameters and requests are supported in addition to the original standard that greatly enhance the
possibilities of customizing its behavior thanks to the QGIS rendering engine.

3.1 Fundamentos

This section describes concepts and parameters mutually shared by services. Some of these are standard and defined
in OGC specifications while others are very specific to QGIS Server.

Conceitos padrio:

Conceito  Descrigao

SERVICE ~ Nome do servi¢o
REQUEST  Nome da requisi¢cao

Conceitos de fornecedor:

Conceito Descricao

MAP arquivo de projeto QGIS
FILE NAME  Nome do arquivo do arquivo baixado
Nome curto Defini¢do de nome curto
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3.1.1 SERVICE

This standard parameter allows to specify the name of the service to use for a specific request and has to be formed
like SERVICE=NAME.

URL example for the WMS service:

http://localhost/ggisserver?
SERVICE=WMS
&ooo

Nota: Not available for REST based services like WFS3 (OGC API Features).

3.1.2 REQUEST

This standard parameter allows to specify the name of the request to execute for a specific service and has to be
formed like REQUEST=RequestName.

URL example for the GetCapabilities request:

http://localhost/ggisserver?
REQUEST=GetCapabilities
&...

Nota: Not available for REST based services like WFS3 (OGC API Features).

3.1.3 MAP

This vendor parameter allows to define the QGIS project file to use. It may be an absolute path or a path relative
to the location of the server executable qgis_mapserv.fcgi. MAP is mandatory by default because a request
needs a QGIS project to actually work. However, the QGIS_PROJECT_FILE environment variable may be used
to define a default QGIS project. In this specific case, MAP is no longer a required parameter. For further information
you may refer to the Configuracao avancada chapter.

Exemplo de URL:

http://localhost/ggisserver?
MAP=/tmp/QGIS-Training-Data/exercise_data/ggis—server—-tutorial-data/world.qggs
&o oo

3.1.4 FILE_NAME

Se este parametro do fornecedor for definido, a resposta do servidor serd enviada ao cliente como um anexo de arquivo
com o nome do arquivo especificado.

URL example to save an XML GetCapabilities document:

http://localhost/ggisserver?
SERVICE=WMS
&REQUEST=GetCapabilities
&FTILE_NAME=wms_capabilities.xml
&o oo
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Nota: Not available for REST based services like WFS3 (OGC API Features).

3.1.5 Nome curto

A number of elements have both a short name and a title. The short name is a text string used for machine-to-machine
communication while the title is for the benefit of humans. For example, a dataset might have the descriptive title
“Maximum Atmospheric Temperature” and be requested using the abbreviated short name “ATMAX”. You can set title,
short name and abstract for:

¢ Layers: right-click on a layer and choose Properties... » QGIS Server w Description.
* Groups: right-click on a group and select Set Group WMS data

¢ Project: go to Project » Properties... » QGIS Server » Service Capabilities.

0 Set group WMS data

Short name

Title

Abstract

| Cancel Save

Figura3.1: Set group WMS data dialog

Assim, o nome abreviado pode ser usado para identificar esses itens ao interagir com o Servidor QGIS. Por exemplo,
com o parametro padrdo CAMADAS:

http://localhost/ggisserver?
SERVICE=WMS

&REQUEST=GetMap
&LAYERS=shortnamel, shortname?2
&...

3.2 Web Map Service (WMS) Servico de mapa de web

Os padroes WMS 1.1.1 e 1.3.0 implementados no servidor do QGIS fornecem uma interface HTTP para solicitar
imagens de mapas ou legendas geradas a partir de um projeto QGIS. Uma solicitacio WMS tipica define o projeto
QGIS a ser usado, as camadas a serem renderizadas, bem como o formato de imagem a ser gerado. O suporte basico
também estd disponivel para Styled Layer Descriptor (SLD)

Especificagdes:
* WMS 1.1.1
* WMS 1.3.0
e SLD 1.1.0 WMS profile

Solicitacdes padrdes providas pelo servidor do QGIS:
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Solicitagéo Descrigao

GetCapabilities ~ Retorna metadados XML com informagdes sobre o servidor
GetMap Retorna um mapa

GetFeaturelnfo ~ Recupera dados (geometria e valores) para uma localizacdo de pixel
GetLegend- Retorna os simbolos das legendas

Graphic

GerStyle(s) Retorna documento XML com descri¢do de estilo no SLD

DescribeLayer — Retorna informagdes sobre a disponibilidade de WFS e WCS, respectivamente, para camadas
vetoriais e raster

Pedidos vendor fornecidos pelo QGIS Server:

Solicitacao Descricao
GetPrint Retorna um layout QGIS
GetProjectSettings Retorna informacio especifica sobre o servidor do QGIS

GetSchemaExtension — Retorna metadados XML sobre recursos estendidos opcionais

3.2.1 GetCapabilities

Parametros padrdes para o pedido GetCapabilities de acordo com as especificagdes OGC WMS 1.1.1 e 1.3.0:

Parametros Requerido Descricao

SERVICE Sim Nome do servico (WMS)
REQUEST Sim Nome do pedido (GetCapabilities)
VERSION Nio Versao do servigo

O pedido do GetCapabilities também suporta os seguintes parametro:

Parametros Requerido Descricdo
MAP Sim arquivo de projeto QGIS

Exemplo de URL:

http://localhost/ggisserver?
SERVICE=WMS

SION=1.3.0
&REQUEST=GetCapabilities

3.2.2 GetMap

Pardmetros padrdes para o pedido de **GetMap* que esteja consoante as especificacoes OGC WMS 1.1.1e 1.3.0
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Parametros Requerido Descrigcao

SERVICE Sim Nome do servico (WMS)

REQUEST Sim Nome do pedido (** GetMap**)

VERSION Sim Versdo do servico

LAYERS Nao Camadas para mostrar

STYLES Nio Estilo das camadas

SRS / CRS Sim Sistema de referéncia de coordenadas

BBOX Sim Extensdao do mapa

WIDTH Sim Largura da imagem em pixels

HEIGHT Sim Altura da imagem em pixels

FORMAT Nio Formato de imagem

TRANSPARENT Nao Plano de fundo transparente

SLD Nao URL do SLD para ser usado para estilizacio
SLD_BODY Nao SLD em linha (XML) para ser usado para estiliza¢do

Em adic@o aqueles que sdo padrdes, o servidor do QGIS suporta redlining, external WMS layers como também as 0s

seguintes parametros extras:

Parametros Re- Descricao

querido
MAP Sim arquivo de projeto QGIS
BGCOLOR Nao Especificar a cor de fundo
DPI Nao Especificar a resolugdo de saida
IMAGE_QUALITY Nao Compressdo JPEG
OPACITIES Nao Opacidade para camada ou grupo
FILTER Nio Subconjunto de caracteristicas
SELECTION Nao Recursos de destaque
FILE_NAME Nio Nome do arquivo do arquivo baixado

FORMAT OPTIONS Niao

TILED Nao

Somente para o FORMAT=application/dxf"

Opc¢des do formato de arquivo especificado

Somente para o FORMAT=application/dxf"

Trabalhando no tiled mode

Exemplo de URL:

http://localhost/ggisserver?

SERVICE=WMS
&VERSION=1.3.0
&REQUEST=GetMap

&MAP=/home/qgis/projects/world.qgs
:S=mylayerl,mylayer2,mylayer3

ITIES=125,200,125
C EPSG:4326

&WIDTH=400

&HEIGHT=400

&FORMAT=image/png

& TRANSPARENT=TRUE

&DPI=300

& TILED=TRUE

ES=stylel,default, style3

3.2. Web Map Service (WMS) Servico de mapa de web
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VERSION
Este pardmetro permite especificar a versdo do servigco a ser utilizada. Os valores disponiveis para o pardmetro
VERSAOQ sdo:

e 1.1.1

e 1.3.0

De acordo com o nimero da versdo, diferencas sutis t€m de ser esperadas como explicado depois para os proximos
parimetros:

* CRS /SRS

¢ BBOX

LAYERS

Este parAmetro permite especificar as camadas a serem exibidas no mapa. Os nomes devem ser separados por virgula.
Em adic¢@o, o servidor do QGIS introduziu algumas opg¢des para selecionar camadas por:

« the layer id: the project option allowing to select layers by their id is in QGIS Server » WMS tab of the Project
» Properties... dialog. Check the Use layer ids as names checkbox to activate this option.

¢ a short name

http://localhost/ggisserver?
SERVICE=WMS

&REQUEST=GetMap
&LAYERS=mylayeridl, mylayerid2
&...

STYLES

Este parametro pode ser usado para especificar o estilo de uma camada para a etapa de renderizacio. Os estilos
devem ser separados por virgula. O nome do estilo padrdo é padré&o.

SRS /CRS

Esse parametro permite indicar a saida do sistema de referéncia espacial do mapa no WMS 1.1.1 e tem que ser
formado cmo EPSG : XXXX. Note que CRS € também suportado se versdo atual € 1.1.1

Para o WMS 1.3.0, o parametro CRS € preferivel, mas SRS € também suportado.

Note que se ambos os pardmetros CRS “~ e SRS sdo indicados no pedidos, entdo € a versdo atual que € indicada
no parimetro VERSION, o qual é decisivo.

No préximo caso, o parimetro -~ SRS™ é mantido independente de qual seja o pardmetro =~ VERSION™, porque o
“*CRS” nio ¢ indicado.

http://localhost/ggisserver?

No préximo caso, o pardmetro SRS * ° € mantido ao invés do "' CRS, devido ao parametro VERSION.
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http://localhost/ggisserver?
SERVICE=WMS
&REQUE
&VERSION=
&CRS=EPSG:4326
&SRS=EPSG:2854

No préximo caso, o parametro CRS é mantido ao invés do SRS devido ao VERSION. Parémetro:

http://localhost/ggisserver?
SERVICE=WMS

&REQUEST=GetMap
&VERSION=1.3.0
&CRS=EPSG:4326

& SRS=EPSG:2854

&...

BBOX
Este pardmetro permite especificar a extensdo do mapa com unidades de acordo com o SRC atual. As coordenadas
devem ser separadas por virgula.

O parametro BBOX é formado comomin_a, min_b, max_a, max_b e adefinicdo do eixo b € diferente de acordo
com a versio atual do parametro VERSION.

¢ No WMS 1.1.1, a ordenac@o do eixo € sempre leste/norte.
* no WMS 1.3.0, a ordenacao do eixo depende da autoridade do CRS.

Por exemplo, no caso do EPSG:4326 ¢ WMS 1.1.1, a é a longitude (leste) e b ¢ a latitude (norte), levando a um
pedido como:

http://localhost/ggisserver?
SERVICE=WMS

&REQUEST=GetMap
&§VERSION=1.1.1
&SRS=epsg:4326
&BBOX=-180,-90, 180, 90

&...

Mas no do WMS 1.3.0, a ordenagfo do eixo definida no banco de dados do EPSG é norte/leste, entdo a € a latitude
e b € a longitude.

http://localhost/ggisserver?
SERVICE=WMS

&REQUEST=GetMap
&VERSION=1.3.0
&CRS=epsg:4326
&BBOX=-90,-180, 90,180

&...
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WIDTH

Este parametro permite especificar a largura em pixels da imagem de saida.

HEIGHT

Este parametro permite especificar a altura em pixels da imagem de saida.

FORMAT

Este parametro pode ser usado para especificar o formato da imagem do mapa. Os valores disponiveis sdo:
* Jjpg
* Jjpeg
* image/jpeg
* image/png
* image/png; mode=1bit
* image/png; mode=8bit
* image/png; mode=16bit
* image/webp

* application/dxf: somente camadas que possuem acesso no servico WFES sdo exportadas no formato
DXF

* application/pdf
Exemplo de URL:

rhttp://localhost/qgisserver?
SERVICE=WMS&VERSION=1.3.0

&REQU

&FORM!

&LAYERS=Haltungen,Normschacht, Spezialbauwerke

&CRS=EPSG%3A21781
&BBOX=696136.28844801,245797.12108743,696318.91114315,245939.25832905
&WIDTH=1042

&HEIGHT=811

&FORMAT_ _OPTIONS=MODE:SYMBOLLAYERSYMBOLOGY; SCALE:250
&FILE_NAME=plan.dxf

TRANSPARENT
Este parametro booleano pode ser usado para especificar a transparéncia do plano de fundo. Os valores disponiveis
sdo (ndo diferenciam maitsculas de mintsculas):

e TRUE

e FALSE

No entanto, este parametro € ignorado se o formato da imagem indicado com FORMATO for diferente de PNG.
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BGCOLOR

Esse parametro permite indicar uma cor de fundo para a imagem do mapa. De qualquer forma, ndo pode ser combi-
nado com o pardmetro TRANSPARENTE no caso de imagens PNG (a transparéncia ganha prioridade). A cor pode
ser literal ou na notac¢@o hexadecimal.

Exemplo de URL com a notag@o literal:

http://localhost/ggisserver?
SERVICE=WMS
&REQUEST=GetMap
&VERSION=1.3.0

GCOLOR=green

Exemplo de URL com a nota¢@o hexadecimal:

http://localhost/ggisserver?

&REQUEST=GetMap
&VERSION=1.3.0
&BGCOLOR=0x00FFQO0
&ooo

DPI

Este parametro pode ser usado para especificar a resolugio de saida solicitada.

IMAGE_QUALITY

Este parametro é usado apenas para imagens JPEG. Por padrio, a compressdo JPEG é - 1.

Vocé pode mudar o padrio para cada projeto de QGIS no menu OWS Server » WMS capabilities da caixa de didlogo
Project » Properties.... Se vocé quer sobrepor em um pedido GetMap, vocé pode faze-lo usando o parametro
IMAGE_QUALITY

OPACITIES

A virgula separa a lista de valores de opacidade. A opacidade pode ser configurada na camada ou a nivel de grupo.
Permitindo valores que vao desde de 0 (completamente transparente) para 255 (completamente opaco)

Exemplo de URL.:

http://localhost/ggisserver?
SERVICE=WMS

&REQUEST=GetMap
&VERSION=1.3.0

&WIDTH=400

&HETIGHT=200

&CRS=EPSG:4326
&LAYERS=countries,places
&BBOX=42,-6,52,15
&OPACITIES=255,0
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Figura3.2: A esquerda OPACIDADES=255, 0 e a direita OPACIDADES=255, 255

FILTER

Um subconjunto de camadas pode ser selecionado com o parametro F ILTRO. A sintaxe € basicamente a mesma para
a linha de subconjuntos do QGIS. No entanto, hd algumas restri¢des para evitar injecdes de SQL no banco de dados
via servidor SQL. Se uma linha de cédigo perigosa € achada no parametro, o servidor do QGIS retornara o seguinte
erro:

<ServiceExceptionReport>

<ServiceException code="Security">The filter string XXXXXXXXX has been rejected.
—because of security reasons.

Note: Text strings have to be enclosed in single or double gquotes. A space.
—between each word / special character is mandatory.

Allowed Keywords and special characters are IS,NOT,NULL,AND,OR,IN,=,<,=<,>,>=,6 1=,
~',',(,),DMETAPHONE, SOUNDEX.

Not allowed are semicolons in the filter expression.</ServiceException>
</ServiceExceptionReport>

Exemplo de URL:

http://localhost/ggisserver?

SERVICE=WMS

&REQUEST=GetMap

&VERSION=1.3.0

&WIDTH=400

&HEIGHT=300

&CRS=EPSG:4326

&BBOX=41,-6,52,10

&LAYERS=countries_shapeburst, countries,places

&FILTER=countries_shapeburst, countries:"name" = 'France';places: "name" = 'Paris'
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Figura3.3: Resposta do servidor para um pedido GetMap com pardmetro FILTER

Neste exemplo, o mesmo filtro "name" = 'Paris' € aplicado para camadas countries e coun-
tries_shapeburst, enquanto o filtro "name" = 'Paris' é somente aplicivel para ~places’.

Nota: E possivel fazer pesquisas de atributos vi GetFeatureInfo e omitir o parAmetro X/Y se um FILTER est4 14.
O servidor do QGIS entdo retorna informagdes sobre caracteristicas correspondentes e gera uma caixa limitadora
combinada na saida do XML

SELECTION

O parametro SELECTION pode destacar caracteristicas de uma ou mais camadas. Atributos de vetor podem ser
selecionados por uma virgula separando listas com o atributo ids

http://localhost/ggisserver?

SERVICE=WMS

&REQUEST=GetMap
&LAYERS=mylayerl,mylayer2
&SELECTION=mylayerl:3,6,9;mylayer2:1,5,6
&ooo

A seguinte imagem apresenta a resposta para um pedido GetMap usando a op¢do SELECTION e.g. http://
myserver.com/...&SELECTION=countries:171, 65.

Como esses id’s de recurso correspondem no banco de dados fonte para France e Romania eles sio destacados em
amarelo
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Figura3.4: A resposta do servidor para pedido GetMap com o parametro SELECTION.

FORMAT_OPTIONS

This parameter can be used to specify options for the selected format. Only for FORMAT=application/dxf in
GetMap request. Takes a list of key:value pairs separated by semicolon:

e SCALE: para ser usada para regras de simbologia, filtros e estilos (Nao € a escala real dos dados - o dado
continua na escala original)

* MODE: corresponde as opgdes de exportacio oferecidas na caixa de didlogo QGIS Desktop DXF. Possiveis
valores s30 NOSYMBOLOGY ", " FEATURESYMBOLOGY e SYMBOLLAYERSYMBOLOGY".

* LAYERATTRIBUTES: specify a field or in case of many layers a comma separated list of fields that contains
values for DXF layer names - if not specified, the original QGIS layer names are used.

e USE_TITLE_AS_LAYERNAME: se habilitado, o titulo da camada sera usa como o nome da camada.

* CODE: especifique um codec para ser usado para codificagdo. O padrio é ISO-8859—-1. Marque a caixa de
didlogo QGIS desktop DXF para valores validos.

¢ NO_MTEXT: Usa texto em vez de MTEXT para rétulos.
¢ FORCE_2D: Saida Force 2D. Isso € requerido para a largura do polyline.
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TILED

Por motivos de performance, o servidor do QGIS pode ser usado em modo lado a lado (tiled). Nesse modo, o cliente
pedi varios pequenos ladrilhos fixos e entdo junta-os para formar o mapa inteiro. Fazendo isso, simbolos em cima ou
perto do limite entre dois ladrilhos talvez aparecam cortados porque eles estdo presentes somente em um dos ladrilhos

Configure o pardmetro TILED para = TRUE“para dizer ao servidor do QGIS para trabalhar em modo tiled e para
aplicar o Tile bufer configurado no projeto do QGIS (veja ref:Creatingwmsfromproject).

Quando TILED"™ ° ¢é ' TRUE e quando um ndo zeri Tile buffer é configurado no projeto do QGIS, caracteristicas
fora do ladrilho estendido sdo desenhadas para evitar simbologias cortadas nos limites do ladrilho.

TILED padronizado em FALSE™.

3.2.3 GetFeaturelnfo

Parametros padrio para o pedido GetFeatureInfo de acordo com as especificagdes do OGC WMS 1.1.1 e 1.3.0:

Paramet- Re- Descricdo

ros queric

SER- Sim  Nome do servico (WMS)

VICE

RE- Sim  Nome do pedido (GetFeatureInfo)
QUEST

VER- Nao  Versio do servigo

SION

QUERY_I Sim  Camadas para consulta

LAYERS Sim  Camadas para mostrar (idénticas ao QUERY_LAYERS)
STYLES Niao  Estilo das camadas

SRS/ Sim  Sistema de referéncia de coordenadas

CRS

BBOX Niao  Extensdo do mapa

WIDTH  Sim  Largura da imagem em pixels

HEIGHT Sim  Altura da imagem em pixels

TRANS- Nao Plano de fundo transparente

PAR-

ENT

INFO_FO Nao Formato de saida

FEA- Nao Numero miximo de fei¢ces a serem retornadas
TURE_CC

1 Nido Coluna de pixels do ponto para consultar

X Nao Igual ao parametro /, mas em WMS 1.1.1

J Nao Linhas de pixels do ponto para consultar.

Y Nao Igual ao parametro J, mas em WMS 1.1.1

WMS_PR Nao A precisdo (nimeros de digitos) para ser usado quando retornando uma geometria (veja how
para adicionar geometria a resposta do do recurso). O valor padrdo é —1 o que signigica que a
preciséo definida no projeto € usada.

Além dos padrdes, o QGIS Server suporta os seguintes parametros extras:
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Parametros Requerido Descricao
MAP Sim arquivo de projeto QGIS
FILTER Nao Subconjunto de caracteristicas
FI_POINT _TOLERANCE Nao Tolerancia em pixels para camadas de ponto
FI LINE TOLERANCE Nio Tolerancia em pixels para camadas de linha
FI_POLYGON_TOLERANCE Nio Tolerancia em pixels para camadas de poligono
FILTER_GEOM Nio Filtragem de geometria
WITH_DISPLAY_NAME Nao Add the feature display name to the output
WITH_MAPTIP Nio Adicione dicas de mapa na saida.
WITH _GEOMETRY Nio Adicionar geometria a saida

Exemplo de URL:

http://localhost/ggisserver?

E=WMS

&VERSION=1.3.0

&REQUEST=GetMap
&MAP=/home/qgis/projects/world.qgs
\WYERS=mylayerl,mylayer2,mylayer3
&CRS=EPSG:4326

&WIDTH=400
&HEIGHT=400
&INFO_FORMAT=text/xml

&TRANSPARENT=TRUE
&QUERY_LAYERS=mylayerl
&FEATURE_COUNT=3
&I=250

&J=250

INFO_FORMAT

Este parametro pode ser usado para especificar o formato do resultado. Os valores disponiveis sdo:
* text/xml
e text/html
* text/plain
e application/vnd.ogc.gml

e application/json

QUERY_LAYERS

Este parametro especifica as camadas a serem exibidas no mapa. Os nomes sdo separados por uma virgula.
Em adic¢@o, o servidor do QGIS introduz opcdes para selecionar camadas por:

* nome curto

¢ camada id

Veja o pardmetro LAYERS definido no GetMap para mais informacgdes.
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FEATURE_COUNT

This parameter specifies the maximum number of features per layer to return. For example if QUERY_LAYERS
issetto layerl, layer2 and FEATURE_COUNT is set to 3 then a maximum of 3 features from layer1 will be
returned. Likewise a maximum of 3 features from layer2 will be returned.

Por padrio, apenas 1 fei¢do por camada é retornada.

Este parametro, definido no WMS 1.3.0, permite especificar a coluna de pixel do ponto de consulta.

X

Mesmo parametro que I, mas definido no WMS 1.1.1.

J

Este parametro, definido no WMS 1.3.0, permite especificar a linha de pixel do ponto de consulta.

Y

Mesmo pardmetro que J, mas definido no WMS 1.1.1.

FI_POINT_TOLERANCE

Este parametro especifica a tolerancia em pixels para camadas de pontos.

FI_LINE_TOLERANCE

Este parametro especifica a tolerancia em pixels para camadas de linha.

FI_POLYGON_TOLERANCE

Este parametro especifica a tolerancia em pixels para camadas de poligono.

FILTER_GEOM

Esse parametro especifica uma geometria WKT na qual cada caracteristica tem quer se intersectar

WITH_DISPLAY_NAME

This parameter specifies whether to add feature display name to the output.
Valores disponiveis sdo (ndo em caso sensiveis):
e TRUE

e FALSE
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WITH_MAPTIP

Esse parametro especifica se serd ou ndo adicionadas dicas de mapa na saida.
Valores disponiveis sdo (ndo em caso sensiveis):

e TRUE

e FALSE

e HTML_FI_ONLY_MAPTIP: like TRUE, with the difference that the HTML response to the feature info re-
quest only contains the maptip. This gives full control over the HTML response using e.g. the built-in layer
maptip editor.

WITH_GEOMETRY

Esse parametro especifica se adiciona-se ou ndo as geometrias na saida. Para usar esse recurso vocé deve primeiro
habilitar a seguinte op¢do no projeto do QGIS Adicionar geometria para a resposta do recurso para adicionar a ge-
ometria a resposta do recurso. Veja Configure your project.

Valores disponiveis sdo (ndo em caso sensiveis):
e TRUE

e FALSE

3.2.4 GetLegendGraphic

Standard parameters for the GetLegendGraphic request according to the OGC WMS 1.1.1 and 1.3.0 specifications:

Parametros Requerido  Descricao

SERVICE Sim Nome do servico (WMS)

REQUEST Sim Name of the request (GetLegendGraphic)
VERSION Nao Versao do servico

LAYERS Sim Camadas para mostrar

STYLES Nao Estilo das camadas

SRS /CRS Nao Sistema de referéncia de coordenadas
BBOX Nio Extensdo do mapa

WIDTH Nio Largura da imagem em pixels
HEIGHT Nao Altura da imagem em pixels
FORMAT Nao Formato da legenda

TRANSPARENT Nio Plano de fundo transparente

Em adic@o aos padrdes, o servidor do QGIS suporta pardmetros extras para alterar o tamanho dos elementos da
legenda ou a propriedade das fontes por titulo de camada e rétulos de itens:
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Parametros Requerido Descricdo
MAP Sim arquivo de projeto QGIS
SRCWIDTH Nao Largura do mapa
SRCHEIGHT Nao Altura do mapa
SHOWFEATURECOUNT Nio Adicionar recurso de contador de recursos
RULE Nao Regra simbolo para renderizar.
RULELABEL Nio Renderizacgdo do item “rétulos”
BOXSPACE Nao Espaco entre o quadro da legenda e o contetido (mm)
LAYERSPACE Nao Espaco vertical entre camadas (mm)
LAYERTITLESPACE Nao Espaco vertical entre o titulo da camada e os itens (mm)
SYMBOLSPACE Nio Espaco vertical entre o simbolo e os itens (mm)
ICONLABELSPACE Nao Espaco horizontal entre o simbolo e o rétulo (mm)
SYMBOLWIDTH Nao Largura da pré-visualizagdo do simbolo (mm)
SYMBOLHEIGHT Nao Altura da visualiza¢do do simbolo (mm)
LAYERTITLE Nao Renderiza¢io da camada “titulo”
LAYERFONTFAMILY Nio Familia de fontes da camada
LAYERFONTBOLD Nio Renderizagio em negrito do titulo da camada
LAYERFONTSIZE Nao Tamanho da fonte do titulo da camada (pt)
LAYERFONTITALIC Nao Renderizagdo em itdlico do titulo da camada
LAYERFONTCOLOR Nao Cor do titulo da camada
ITEMFONTFAMILY Nio Familia de fontes do item
ITEMFONTBOLD Nio Renderizagio em negrito do rétulo do item
ITEMFONTSIZE Nao Tamanho da fonte do rétulo do item (pt)
ITEMFONTITALIC Nao Renderizagdo em itdlico do item “rétulo”
ITEMFONTCOLOR Nao Cor do rétulo do item
SHOWRULEDETAILS Nao Adds the rule text to JSON output
ADDLAYERGROUPS Nio Adds the layer groups to JSON output

BBOX

Esse parimetro pode ser usado para especificar a drea geogréfica para qual a legenda deve construir (seu formato é
descrito como /ere) mas ndo pode ser combinado com o pardmetro REGRA . Os parametros SRS/CRS se tornam
mandatoérios quando usando o pardmetro BBOX.

Exemplo de URL:

http://localhost/ggisserver?
SERVICE=WMS
&REQUEST=GetLegendGraphic
&LAYERS=countries,airports
=43.20,-2.93,49.35,8.32
&CRS=EPSG:4326

Nota: Quando o pardmetro BBOX € definido, a legenda € referida como Legenda baseada em conteiido
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WIDTH

Esse parametro ndo € usado por padrio, mas se torna mandatério quando o pardmetro RULE € definido. Nesse caso,
permite especificar a largura em pixels da saida da imagem

http://localhost/ggisserver?
SERVICE=WMS
&REQUEST=getlegendgraphic

&L R=testlayer%$20%C3%A8%C3%A9
&RULE=rulel

&WIDTH=30

&HETIGHT=30

HEIGHT

Esse parametro ndo € usado por padrdo, mas se torna mandatério quando o parametro RULE € definido. Nesse caso,
permite especificar a altura em pixels da saida da imagem

http://localhost/ggisserver?
SERVICE=WMS
&REQUEST=GetLegendGraphic
&LAYER=testlayer%20%C3%A8%C3%A9
&RULE=rulel

&WIDTH=30

&HETIGHT=30

FORMAT

Este parametro pode ser usado para especificar o formato da imagem da legenda. Os valores disponiveis sdo:
* image/jpeg
* image/png
e application/Jjson

Para JSON, simbolos sdo encodados com Base64 e a maioria das outras op¢des relacionadas ao layout ou fontes ndo
sdo levadas em consideracio porque a legenda deve ser construida do lado do cliente. O pardmetro REGRA ndo pode
ser combinado com esse formato.

Exemplo de URL com a saida JSON correspondente:

http://localhost/ggisserver?

LAYERS=airportsé&

"ORMAT=application/json

E a saida JSON correspondente:

{

"nodes": [
{
"icon":"<base64 icon>",
"title":"airports",
"type" . n layer"
}
I
"title" 9 nn
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SRCWIDTH

This parameter may de defined when the RULE parameter is set. In this case, the SRCWIDTH value is forwarded to
the underlying GetMap request as the WIDTH parameter while the WIDTH parameter of Get LegendGraphic
is used for the image legend size.

SRCHEIGHT

This parameter may de defined when the RULE parameter is set. In this case, the SRCHEIGHT value is forwarded to
the underlying GetMap request as the HEIGHT parameter while the HEIGHT parameter of Get LegendGraphic
is used for the image legend size.

SHOWFEATURECOUNT
Esse pardmetro pode ser usado para ativar o recurso de contagem na legenda. Valores disponiveis sdo (nfo séo case
sensitives):

e TRUE

e FALSE

Por exemplo:

Tram lines [10]
—— 1[2]
— 2 2]

3 [4]

4[2]

RULE

This parameter is available on layers with Rule-based rendering and allows to build a legend with only the named rule
symbol. It cannot be combined with BBOX parameter. HEIGHT and WIDTH must be specified.

Exemplo de URL:

http://localhost/ggisserver?
SERVICE=WMS
&REQUEST=GetLegendGraphic
&LAYERS=mylayer,
&RULE=myrulename,

&§WIDTH=20,

&HETIGHT=20

RULELABEL

Esse parametro permite controlar a renderizacio do rétulo do item. Valores disponiveis sdo (ndo case sensitives):
* VERDADEIRO: exibe o rétulo do item
* FALSO': oculta o rétulo do item
e AUTO: esconde o rétulo do item para camadas com renderizagdo Simbolo tinico

Exemplo de URL:
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http://localhost/ggisserver?
SERVICE=WMS
&REQUEST=GetLegendGraphic
&LAYERS=countries,airports
&BBOX=43.20,-2.93,49.35,8.32
&CRS=EPSG:4326
&TRANSPARENT=TRUE
&RULELABEL=AUTO

airports

4

countries

B France
[] Germany
) italy

B jersey
[ Monaco
B spain

[ switzerland

Figura3.5: Renderizar legenda sem rétulo para camadas de simbolo tnico.

BOXSPACE

Este parametro permite especificar o espaco entre o quadro da legenda e o contetido em milimetros. Por padréo, o

valor do espago € 2 mm.

Exemplo de URL:

http://localhost/ggisserver?
SERVICE=WMS
&REQUEST=GetLegendGraphic
&LAYERS=airports
&BBOX=43.20,-2.93,49.35,8.32
&CRS=EPSG:4326
&TRANSPARENT=TRUE
&BOXSPACE=0
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airports

+ airports

airports

+ airports

Figura3.6: Para a esquerda BOXSPACE=0 e para a direita BOXSPACE=15

LAYERSPACE

Este parametro permite especificar o espago vertical entre as camadas em milimetros. Por padrio, o valor do espaco
¢ 3 mm.

Exemplo de URL:

http://localhost/ggisserver?
SERVICE=WMS
&REQUEST=GetLegendGraphic
&LAYERS=airports,places
&BBOX=43.20,-2.93,49.35,8.32
&CRS=EPSG:4326
&TRANSPARENT=TRUE
&LAYERSPACE=0

places
places © places
{E.‘J places .
airports airports
+ airports 4*\ airports

Figura3.7: Para a esquerda LAYERSPACE=0 e para a direita LAYERSPACE=10

LAYERTITLESPACE

Este parametro permite especificar o espaco vertical entre o titulo da camada e os itens seguintes em milimetros. Por
padrdo, o valor do espago € 3 mm.

Exemplo de URL:

http://localhost/ggisserver?
SERVICE=WMS
&REQUEST=GetLegendGraphic
&LAYERS=airports,places
&BBOX=43.20,-2.93,49.35,8.32
&CRS=EPSG:4326

(continua na proxima pagina)
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(continuagdo da pagina anterior)
&TRANSPARENT=TRUE
&LAYERTITLESPACE=0

places
@ places
places )
airports
= places
airports
+ airports + airports

Figura3.8: Para a esquerda LAYERTITLESPACE=0 e para a direita LAYERTITLESPACE=10

SYMBOLSPACE

Este parametro permite especificar o espago vertical entre o simbolo e o item seguinte em milimetros. Por padrdo, o
valor do espago € 2 mm.

Exemplo de URL:

http://localhost/ggisserver?
SERVICE=WMS
&REQUEST=GetLegendGraphic
&LAYERS=countries
&BBOX=43.20,-2.93,49.35,8.32
&CRS=EPSG:4326

& TRANSPARENT=TRUE
&SYMBOLSPACE=0

countries

B rrance
[ ] Germany

[ italy
countries

B jerse
France 4
Germany
italy [ Monaco
Jersey
Monaco B spain
Spain
Switzerland [ switzerland

Figura3.9: Para a esquerda SYMBOLSPACE=0 e para a direita SYMBOLSPACE=5
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ICONLABELSPACE

Este parametro permite especificar o espaco horizontal entre o simbolo e o texto do rétulo em milimetros. Por padrio,
o valor do espago € 2 mm.

Exemplo de URL:

http://localhost/ggisserver?
SERVICE=WMS
&REQUEST=getlegendgraphic
&LAYERS=countries,
&BB0OX=43.20,-2.93,49.35,8.32
&CRS=EPSG:4326

& TRANSPARENT=TRUE
&ICONLABELSPACE=0

countries countries

Bance B France
[Germany ] Germany
[ taly ] Italy

Pl ersey 1 Jersey

[ Monaco ] Monaco
P pain 1 Spain

[ Ewitzerland ] Switzerland

Figura3.10: Para a esquerda ICONLABELSPACE=0 e para a direita ITCONLABELSPACE=10

SYMBOLWIDTH

Este parAmetro permite especificar a largura da visualizagio do simbolo em milimetros. Por padrao, o valor da largura
¢ 7 mm.

Exemplo de URL:

http://localhost/ggisserver?
SERVICE=WMS
&REQUEST=GetLegendGraphic
&LAYERS=countries,
&BBOX=43.20,-2.93,49.35,8.32
&CRS=EPSG:4326
&TRANSPARENT=TRUE
&SYMBOLWIDTH=2
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countries countries

B France I France
[ Germany [ Germany
0 1aly (T

B jersey I jersey

[l Monaco [ ) Monaco

B spain N spain

[ switzerland [ switzerland

Figura3.11: Para a esquerda SYMBOLWIDTH=2 e para a direita SYMBOLWIDTH=20

SYMBOLHEIGHT

Este parametro permite especificar a altura da visualiza¢do do simbolo em milimetros. Por padrdo, o valor da altura
é 4 mm.

Exemplo de URL:

http://localhost/ggisserver?
SERVICE=WMS
&REQUEST=GetLegendGraphic
&LAYERS=countries,
&§BBOX=43.20,-2.93,49.35,8.32
&CRS=EPSG:4326

& TRANSPARENT=TRUE
&SYMBOLHEIGHT=2

countries

countries - Italy

BN France - Jersey
=0 Germany

m Italy - Monaco

B |ersey

B Monaco - Spain
S spain .

mm Switzerland - Switzerland

Figura3.12: Para a esquerda SYMBOLHEIGHT=2 e para a direita SYMBOLHEIGHT=6
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LAYERTITLE

Esse parametro especifica se renderiza ou ndo o titulo da camada
Valores disponiveis sdo (ndo em caso sensiveis):
e VERDADEIRO (valor padrio)

e FALSE

LAYERFONTFAMILY

Esse parametro especifica a familia da fonte para a ser usada para renderizar o titulo da camada

http://localhost/ggisserver?
SERVICE=WMS
&REQUEST=GetLegendGraphic
&LAYERS=countries
&LAYERFONTEFAMILY=monospace

LAYERFONTBOLD

Esse pardmetro especifica se o titulo da camada serd renderizado em negrito.

sensitives):
e TRUE
e FALSE

Exemplo de URL:

Valores disponiveis sdo (ndo case

http://localhost/ggisserver?
SERVICE=WMS
&REQUEST=GetLegendGraphic
&LAYERS=airports,places
&BBOX=43.20,-2.93,49.35,8.32
&CRS=EPSG:4326

& TRANSPARENT=TRUE
&LAYERFONTBOLD=TRUE

places

& places

airports

4+. airports

Figura3.13: legenda com LAYERFONTBOLD=TRUE
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LAYERFONTSIZE

Esse parametro especifica o tamanho da fonte para renderizar o titulo da camada em ponto

Exemplo de URL:

http://localhost/ggisserver?
SERVICE=WMS
&REQUEST=GetLegendGraphic
&LAYERS=airports,places
&BBOX=43.20,-2.93,49.35,8.32
&CRS=EPSG:4326
&TRANSPARENT=TRUE
&LAYERFONTSIZE=20

places

@ places

airports

+ airports

Figura3.14: Legenda com LAYERFONTSIZE=20

LAYERFONTITALIC

Esse parametro especifica se o titulo da camada € renderizado em itdlico. Valores disponiveis sdo (ndo case sensitives):
¢ TRUE
e FALSE

Exemplo de URL:

http://localhost/ggisserver?
SERVICE=WMS
&REQUEST=GetLegendGraphic
&LAYERS=airports,places
&BBOX=43.20,-2.93,49.35,8.32
&CRS=EPSG:4326
&TRANSPARENT=TRUE
&LAYERFONTITALIC=TRUE

places

@  places

airports

+ airports

Figura3.15: Legenda com LAYERFONTITALIC=TRUE
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LAYERFONTCOLOR

Esse pardmetro especifica a cor do titulo da camada. A cor pode ser literal (red, green, ...) ou in notagdo hex-
adecimal (OxFF0000, 0x00FFO0O, ...).

Exemplo de URL:

http://localhost/ggisserver?
SERVICE=WMS
&REQUEST=GetLegendGraphic
&LAYERS=airports,places
&BB0OX=43.20,-2.93,49.35,8.32
&CRS=EPSG:4326

& TRANSPARENT=TRUE
&LAYERFONTCOLOR=0x5£9930

+ airports

Figura3.16: Legenda com LAYERFONTCOLOR=0x5£9930

ITEMFONTFAMILY

Esse parametro especifica a familia da fonte a ser usada para renderizar o rétulo do item

http://localhost/ggisserver?
SERVICE=WMS
&REQUEST=GetLegendGraphic
&LAYERS=countries
&ITEMEONTEAMILY=monospace

ITEMFONTBOLD

Esse parametro especifica se o rétulo do item € renderizado em negrito. Valores disponiveis sdo (ndo case sensitive):
¢ TRUE
e FALSE

Exemplo de URL:

http://localhost/ggisserver?
SERVICE=WMS
&REQUEST=GetLegendGraphic
&LAYERS=airports,places
&BBOX=43.20,-2.93,49.35,8.32
&CRS=EPSG:4326
&TRANSPARENT=TRUE
&ITEMEONTBOLD=TRUE
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places

= places

airports
+ airports

Figura3.17: Legenda com ITEMFONTBOLD=TRUE

ITEMFONTSIZE

Esse parametro especifica o tamanho da fonte para renderizar o titulo da camada em ponto

Exemplo de URL:

http://localhost/ggisserver?
SERVICE=WMS
&REQUEST=GetLegendGraphic
&LAYERS=airports,places
&BBOX=43.20,-2.93,49.35,8.32
&CRS=EPSG:4326
&TRANSPARENT=TRUE
&ITEMFONTSIZE=20

places

@ places

airports

4 airports

Figura3.18: Legenda com ITEMFONTSIZE=30

ITEMFONTITALIC

Esse parametro especifica se o rétulo do item € renderizado em itdlico. Valores disponiveis sdo (ndo case sensitives):

e TRUE
e FALSE

Exemplo de URL.:

http://localhost/ggisserver?
SERVICE=WMS
&REQUEST=GetLegendGraphic
&LAYERS=airports,places
&BBOX=43.20,-2.93,49.35,8.32
&CRS=EPSG:4326

& TRANSPARENT=TRUE

& ITEMFONTITALIC=TRUE
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places

& places

airports

+ airports

Figura3.19: Legenda com ITEMFONTITALIC=TRUE

ITEMFONTCOLOR

Esse parametro especifica a cor do rétulo do item. A cor pode ser literal (red, green, ..) oi em notag¢do hexadecimal
(0XFF0000, 0x00FFO0O, ...).

Exemplo de URL.:

http://localhost/ggisserver?
SERVICE=WMS
&REQUEST=GetLegendGraphic
&LAYERS=airports,places
&BBOX=43.20,-2.93,49.35,8.32
&CRS=EPSG:4326

& TRANSPARENT=TRUE

& ITEMFONTCOLOR=0x5£9930

places

& places

airports

A*\ alrports

Figura3.20: Legenda com ITEMFONTCOLOR=0x5£9930

SHOWRULEDETAILS

This parameter specifies if the JSON output will also contain the details about the rule that generated the legend entry.
This parameter only has effect when the renderer is rule-based or categorized.

Exemplo de URL com a saida JSON correspondente:

http://localhost/ggisserver?
SERVICE=WMS&
REQUEST=GetLegendGraphicé&
LAYERS=airportsé&
FORMAT=application/jsoné&
SHOWRULEDETAILS=TRUE

E a saida JSON correspondente:
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"nodes": [
{
"icon":"<base64 icon>",
"title":"airports",
"type":"layer",

"rule": "type = 'airport'"
}
1,
"title" . nn
}
ADDLAYERGROUPS

This parameter specifies if the JSON output will also display the names of the layers groups (and subgroups) in the
legend entry. Possible values are:

e TRUE: display the groups labels

e FALSE (default): hide the groups labels

layer_a
@ layer_a
top-level-group
layer_b @ layer_a
— | b .
VEE T lines
layer_c layer_b
layer ¢ layer_c
B 1ayer d
layer_d
B 1ayer d

Figura3.21: Legend without (left) and with (right) layer groups labels display

The corresponding JSON output showing groups name would look like:

{ "nodes":
[{ "nodes":
[{ "icon":
—"1VBORWOKGgoAAAANSUhREUgAAABQAAAAUCAYAAACNIRONAAAACXBIWXMAABY1AAAWIQF JUL TWAAAAUk 1EQY
—37128evBKKisr/

704 JWNgGAXDHz.

—0+a7IMiNi93C15DcUpgM4wYQ5nwuZACMIQNVHY3Lu083C0kG0hysoF ZRrINo2AYAQC8 7BpkGQT 1 fFwAAAABJRUSErkJggg==

n
",

"title":"layer_a", "type":"layer"
b
{ "nodes":

[{ "icon":

—"1VBORwWOKGgoAAAANSUhEUgAAABMAAAAUCAYAAABVVQZOAAAACXBIWXMAABY 1AAAWJIQF JUL1 TWwAAAAHULIEQYQ4 JWNgGAW Y C

n
",

"title":"layer_Db", "type":"layer"
by

{ "icon":

—"1VBORWOKGgoAAAANSUhEUgAAABMAAAAUCAYAAABVVQZOAAAACXBIWXMAABY 1AAAWJIQF JU1 TWAAAAHULIEQYQ4 JWNgGAW Y C

—8aaEeMglEwYAAAaIoCzTtn5XoAAAAASUVORKSCYII=",
"title":"layer_c", "type":"layer"
P
"title":"lines", "type":"group"
}I

(continua na préxima pagina)
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(continuac@o da pégina anterior)
{ "icon":
—"1VBORWOKGgoAAAANSUhEUgAAABMAAAATCAYAAABYUDDOMAAAACXBIWXMAABY 1AAAWIQF JULi TWAAARAKKIEQYQ4 JWNUV1X/
—Z0AIWMLAWMDANXmMQKoYxUcCcWUUCNGDRsSIbNSWYWYYACXDAsvQaTuVAAAAAEIFTkSuQmCC",
"title":"layer_d", "type":"layer"
Flo
"title":"top-level-group", "type":"group"
1
"title":""

3.2.5 GetStyle(s)

Parametros padrdo para o pedido GetStyle (ou GetStyles) de acordo com as especificagdes do OGC WMS 1.1.1:

Parametros Requerido Descricao

SERVICE Sim Nome do servico (WMS)
REQUEST Sim Nome do pedido (GetStyle ou GetStyles)
LAYERS Sim Camadas para consulta

O pedido GetStyle também suporta os seguintes pardmetros de fornecimento:

Parametros Requerido Descrigao

MAP Sim arquivo de projeto QGIS

Exemplo de URL:

http://localhost/ggisserver?
SERVICE=WMS

X} =GetStyles
&LAYERS=mylayerl,mylayer2

3.2.6 DescribelLayer

Pardmetros padrio para o pedido DescribeLayer de acordo com as especificagdes OGC WMS 1.1.1 e 1.3.0:

Parametros Requerido Descrigao

SERVICE Sim Nome do servico (WMS)
REQUEST Sim Nome do pedido (DescribeLayer)
LAYERS Sim Camadas para descrever

SLD VERSION Sim Versiao SLD

O pedido DescribeLayer também suporta o seguinte parametros fornecidos:

Parametros Requerido Descricao

MAP Sim arquivo de projeto QGIS

Exemplo de URL:
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http://localhost/ggisserver?
SERVICE=WMS
&REQUEST=Describelayer
&SLD_VERSION=1.1.0
&LAYERS=mylayerl

O documento XML parece assim:

<DescribelayerResponse xmlns="http://www.opengis.net/sld" xmlns:xsi="http://www.w3.
—0org/2001/XMLSchema-instance" xmlns:ows="http://www.opengis.net/ows" xmlns:xlink=
—"http://www.w3.0rg/1999/x1ink" xmlns:se="http://www.opengis.net/se"._
—xsi:schemalLocation="http://www.opengis.net/sld http://schemas.opengis.net/sld/1.
—1.0/Describelayer.xsd">
<Version>1.1.0</Version>
<LayerDescription>
<owsType>wis</owsType>
<se:0OnlineResource xlink:href="http://localhost/ggisserver" xlink:type=
—"simple"/>
<TypeName>
<se:FeatureTypeName>ny_vector_layer</se:FeatureTypeName>
</TypeName>
</LayerDescription>
<LayerDescription>
<owsType>wcs</owsType>
<se:OnlineResource xlink:href="http://localhost/ggisserver" xlink:type=
—"simple"/>
<TypeName>
<se:FeatureTypeName>nmy_raster_layer</se:FeatureTypeName>
</TypeName>
</LayerDescription>
</DescribelLayerResponse>

SLD_VERSION

Este pardmetro permite especificar a versdo do SLD. Apenas o valor 1.1 . 0 esta disponivel.

3.2.7 GetPrint

O servidor do QGIS tem a capacidade de criar uma saida de impressdo de layout em formato PDF ou pixel. Janelas
de layout de impressdo no projeto publicado sdo usados como templates. No pedido GetPrint, o cliente tem a
possibilidade de especificar os parametros dos rétulos e mapas contidos no layout.

O pedido GetPrint suporta redlining, external WMS layers assim como 0s seguintes parametros:
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Parametros Re- Descricao
querido
MAP Sim arquivo de projeto QGIS
SERVICE Sim Nome do servico (WMS)
REQUEST Sim Nome do pedido (GetPrint)
VERSION Nio Versdo do servigo
LAYERS Nao Camadas para mostrar
TEMPLATE Sim Template de layout para usar
SRS / CRS Sim Sistema de referéncia de coordenadas
FORMAT Nao Formato de saida
FORMAT_OPTIONS Nio Opgdes do formato de arquivo especificado
Only for FORMAT=application/pdf
ATLAS_PK Nao Feicoes Atlas
STYLES Nao Estilo das camadas
TRANSPARENT Nao Plano de fundo transparente
OPACITIES Nio Opacidade para camada ou grupo
SELECTION Nio Recursos de destaque
mapX:EXTENT Nao Extensdo do mapa ‘X’
mapX:LAYERS Nio Camadas do mapa ‘X’
mapX:STYLES Nio Estilo das camadas do mapa ‘X’
mapX:SCALE Nao Camadas de escala do mapa ‘X’
mapX :ROTATION Nio Rotagdo do mapa X’
mapX:GRID_INTERVAL Nio Intervalo da grade no eixo y do mapa ‘X’
mapX:GRID_INTERVAL Nio Intervalo da grade no eixo y do mapa X’
Exemplo de URL:

http://localhost/ggisserver?
SERVICE=WMS

&VERSION=1.3.0

&REQUEST=GetPrint
&MAP=/home/qgis/projects/world.qgs
&CRS=EPSG:4326

&FO VIT=png

&TEMPLATE=Layout%201

&map0 :EXTENT=-180,-90, 180, 90
&map0:LAYERS=mylayerl,mylayer2,mylayer3
&map0:0PACITIES=125,200,125
&map0:ROTATION=45

Note o layout do template talvez contenha mais de um mapa. Dessa maneira, se vocé€ quer configurar um mapa
especifico, vocé tem que usar pardmetros mapX : onde X é um nimero positivo que vocé consegue recuperar gragas
ao pedido GetProjectSettings

Por exemplo:

<WMS_Capabilities>

<ComposerTemplates xsi:type="wms:_ExtendedCapabilities">

<ComposerTemplate width="297" height="210" name="Druckzusammenstellung 1">
<ComposerMap width="171" height="133" name="map0"/>

<ComposerMap width="49" height="46" name="mapl"/></ComposerTemplate>
</ComposerTemplates>

</WMS_Capabilities>
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TEMPLATE

Esse parametro pode ser usado para especificar o nome de modelo compositor para imprimir

FORMAT

Este parametro especifica o formato da imagem do mapa. Os valores disponiveis sdo:

png (valor padrdo)
image/png

jele]

jpeg
image/jpeg
sSVg

image/svg
image/svg+xml
pdf

application/pdf

Se o parametro FORMATO for diferente de um desses valores, uma excec¢do serd retornada.

FORMAT_OPTIONS

This parameter can be used to specify options for the selected format. Only for FORMAT=application/pdf in
GetPrint requests. Takes a list of key:value pairs separated by semicolon:

RASTERIZE_WHOLE_IMAGE: whether the whole pdf should be exported as an image. Default: false.
FORCE_VECTOR_OUTPUT: whether pdf should be exported as vector. Default: false.
APPEND_GEOREFERENCE: whether georeference info shall be added to the pdf. Default: true.
EXPORT_METADATA: whether metadata shall be added to the pdf. Default: true.

TEXT_RENDER_FORMAT: sets the text render format for pdf export. It can be AlwaysOut lines (default)
or AlwaysText.

SIMPLIFY_GEOMETRY: whether features geometries shall be simplified. Default: true.
WRITE_GEO_PDF: whether a Geospatial PDF shall be exported. Default: false.

USE_ISO_32000_EXTENSION_FORMAT_GEOREFERENCING: whether Iso32000 georeferencing shall
be used. Default: false.

USE_OGC_BEST_PRACTICE_FORMAT_GEOREFERENCING: whether OGC best practice georeferencing
shall be used. Default: false.

EXPORT_THEMES: a comma separated list of map themes to use for a Geospatial PDF export
PREDEFINED_MAP_SCALES: a comma separated list of map scales to render the map

LOSSLESS_IMAGE_COMPRESSION: whether images embedded in pdf must be compressed using a lossless
algorithm. Default: false.

DISABLE_TILED_RASTER_RENDERING: whether rasters shall be untiled in the pdf. Default: false.

Exemplo de URL:
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http://localhost/ggisserver?

SERVICE=WMS

&VERSION=1.3.0

&REQUEST=GetPrint

&MAP=/home/qgis/projects/world.qgs

&CRS=EPSG:4326

&FORMAT=pdf

&TEMPLATE=Layout%201

M NS=FORCE_VECTOR_OUTPUT : TRUE; TEXT_RENDER_FORMAT:AlwaysOutlines;
—PREDEFINED_MAP_SCALES:250

ATLAS_PK

Este pardmetro permite ativar a renderizag¢do do Atlas indicando quais fei¢cdes queremos imprimir. Para recuperar
um atlas com todas as fei¢des, pode-se utilizar o simbolo * (de acordo com o nimero maximo de fei¢des permitidas
na configuracdo do projeto)..

Quando FORMAT € pdf, um tnico documento PDF combinando as péaginas de recursos é retornado. Para todos os
outros formatos, uma tnica pagina € retornada.

mapX:EXTENT

Este parametro especifica a extensdo de um item de mapa de layout como xmin,ymin,xmax,ymax.

mapX:ROTATION

Este parametro especifica a rotacdo do mapa em graus.

mapX:GRID_INTERVAL_X

Este parametro especifica a densidade da linha de grade na dire¢do X.

mapX:GRID_INTERVAL_Y

Este parametro especifica a densidade da linha de grade na dire¢do Y.

mapX:SCALE
Este parAmetro especifica a escala do mapa para um item de mapa de compositor. Isso € util para garantir a visibilidade

baseada em escala de camadas e rdtulos, mesmo que o cliente e o servidor possam ter algoritmos diferentes para
calcular o denominador de escala.

mapX:LAYERS

Esse pardmetro especifica as camadas para um item de compositor de mapa. Veja. GetMap Layers para mais infor-
magdes desse parametro.
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mapaX:ESTILOS

Esse pardmetro especifica os estilos das camadas definidas em um item compositor especifico de mapa. Veja GertMap
Styles para mais informagdes desse parametro.

3.2.8 GetProjectSettings
Esse tipo de pedido funciona similarmente ao GetCapabilities, mas € mais especifico para o servidor do QGIS e
permite que um cliente leia informacéo adicional aos quais néo sdo disponiveis na saida GerCapabilities:

» visibilidade inicial das camadas

« informacgdes sobre atributos vetoriais e seus tipos de edi¢io

* informacdes sobre ordem de camada e ordem de desenho

* Lista de camadas publicadas em WEFS.

* Mostra se um grupo na camada arvore € mutually exclusive

O pedido **GetProjectSettings**suporta os seguintes parametros:

Parametros Requerido Descrigcao

MAP Sim arquivo de projeto QGIS
SERVICE Sim Nome do servico (WMS)
REQUEST Sim Nome do pedido (GetProjectSettings)

3.2.9 GetSchemaExtension

A solicitacio GetSchemaExtension permite recuperar recursos estendidos opcionais e operagdes do servico WMS,
como implementado pelo QGIS Server.

Parametros Requerido Descricao

MAP Sim arquivo de projeto QGIS
SERVICE Sim Nome do servico (WMS)
REQUEST Sim Nome do pedido (GetSchemaExtension)

Exemplo de URL:

http://localhost/ggisserver?
SERVICE=WMS
&REQUEST=GetSchemaExtension

O documento XML parece assim:

<schema xmlns="http://www.w3.0rg/2001/XMLSchema" xmlns:wms="http://www.opengis.net/
—wms" xmlns:qggs="http://www.ggis.org/wms" targetNamespace="http://www.ggis.org/wms
—" elementFormDefault="qualified" version="1.0.0">

<import namespace="http://www.opengis.net/wms" schemalLocation="http://schemas.
—opengis.net/wms/1.3.0/capabilities_1_3_0.xsd"/>

<element name="GetPrint" type="wms:OperationType" substitutionGroup
—ExtendedOperation"/>

<element name="GetStyles" type="wms:OperationType" substitutionGroup="wms:_

]

wms :_

—ExtendedOperation"/>
</schema>
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3.2.10 Camadas WMS externas

O QGIS Server permite incluir camadas de servidores WMS externos em solicitacdes WMS :ref:”GetMap “ e WMS
:ref:"GetPrint . Isso é especialmente itil se um cliente da web usar uma camada de plano de fundo externa no mapa
da web. Por motivos de desempenho, essas camadas devem ser solicitadas diretamente pelo cliente da Web (ndo em
cascata via servidor QGIS). No entanto, para impressdo, essas camadas devem ser colocadas em cascata via servidor
QGIS para aparecer no mapa impresso.

Camadas externas podem ser adicionadas ao parametro LAYERS como EXTERNAL_WMS:. Os pardmetros para
as camadas WMS externas (por exemplo, url, formato, dpiMode, crs, camadas, estilos) podem ser fornecidos poste-
riormente como pardmetros de servico :. Em uma solicitacio :ref:”GetMap °, isso pode se parecer com isto:

http://localhost/ggisserver?
SERVICE=WMS

QUEST=GetMap
S=EXTERNAL_WMS :basemap, layerl, layer2
&OPACITIES=100,200,255
&STYLES=, ,
&basemap:url=http://externalserver.com/wms.fcgi
&basemap: format=image/jpeg
&basemap:dpiMode=7
&basemap:crs=EPSG:2056
&basemap:layers=orthofoto
&basemap:styles=default

Similarmente, camadas externas podem ser usadas nos pedidos no GetPrint:

http://localhost/ggisserver?

SERVICE=WMS

&REQUEST=GetPrint

&TEMPLATE=A4
&map0:layers=EXTERNAL_WMS:basemap, layerl, layer?2
&map0: EXTENT=<minx,miny, maxx, maxy>
&OPACITIES=100,200,255
&basemap:url=http://externalserver.com/wms.fcgi
&basemap: format=image/jpeg

&basemap:dpiMode=7

&basemap:crs=EPSG:2056
&basemap:layers=orthofoto
&basemap:styles=default

3.2.11 Linha vermelha

Esse atributo estd disponivel e pode ser usado com pedidos GetMap e GetPrint .

O recurso de linha vermelha pode ser usado para passar geometrias e rétulos na solicitacdo que sio sobrepostos pelo
servidor sobre a imagem padrio retornada (mapa). Isso permite que o usudrio coloque énfase ou talvez adicione
alguns comentdrios (rétulos) a algumas 4reas, locais etc. que ndo estdo no mapa padrio.

O pedido GetMap esta no formato:

http://localhost/ggisserver?

SERVICE=WMS

&VERSION=1.3.0

&REQUEST=GetMap

&HIGHLIGHT_GEOM=POLYGON ( (590000 5647000, 590000 6110620, 2500000 6110620, 2500000_
—5647000, 590000 5647000)

&HIGHLIGHT SYMBOL=<StyledLayerDescriptor><UserStyle><Name>Highlight</Name>
—<FeatureTypeStyle><Rule><Name>Symbol</Name><LineSymbolizer><Stroke><SvgParameter..
—name="stroke">%$23eall73</SvgParameter><SvgParameter name="stroke-opacity">1</
—SvgParameter><SvgParameter name="stroke-width">1.6</SvgParameter></Stroke></

(continua na préxima pagina)
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(continuac@o da pégina anterior)
—LineSymbolizer></Rule></FeatureTypeStyle></UserStyle></StyledLayerDescriptor>
&HIGHLIGHT_LABELSTRING=Write label here
&HIGHLIGHT_ LABELSIZE=16
&HIGHLIGHT_LABELCOLOR=%23000000
SHIGHLIGHT LABELBUFFERCOLOR=%23FFFFFF
&HIGHLIGHT_LABELBUFFERSIZE=1.5

O equivalente ao GetPrint estd no formato (note que o parametro mapX: € adicionado para falar qual mapa tem linha
vermelha):

http://localhost/ggisserver?

SERVICE=WMS

&VERSION=1.3.0

&REQUEST=GetPrint

&map0:HIGHLIGHT_GEOM=POLYGON ( (590000 5647000, 590000 6110620, 2500000 6110620, -
—2500000 5647000, 590000 5647000))
&map0:HIGHLIGHT_SYMBOL=<StyledLayerDescriptor><UserStyle><Name>Highlight</Name>
—<FeatureTypeStyle><Rule><Name>Symbol</Name><LineSymbolizer><Stroke><SvgParameter.
—name="stroke">%23eall73</SvgParameter><SvgParameter name="stroke-opacity">1</
—SvgParameter><SvgParameter name="stroke-width">1.6</SvgParameter></Stroke></
—LineSymbolizer></Rule></FeatureTypeStyle></UserStyle></StyledLayerDescriptor>
&map0:HIGHLIGHT LABELSTRING=Write label here

&map0:HIGHLIGHT_LABELSIZE=16

&map0:HIGHLIGHT_LABELCOLOR=%23000000

&map0:HIGHLIGHT LABELBUFFERCOLOR=%23FFFFFF

&map0:HIGHLIGHT _LABELBUFFERSIZE=1.5

Aqui estd a imagem gerada pela solicitacio acima, na qual um poligono e um rétulo sdo desenhados no topo do mapa
normal:
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Belarus.

Figura3.22: Resposta do servidor a uma solicitacdo GetMap com parametros de linha vermelha

Vocé pode ver que hd varios parametros nesta solicitagdo para controlar o recurso de linha vermelha. A lista completa
inclui:

« HIGHLIGHT_GEOM: Vocé pode adicionar POINT, MULTILINESTRING, POLYGON etc. Suporta ge-
ometrias multipartes. Aqui estd um exemplo: HIGHLIGHT_GEOM=MULTILINESTRING((0O 0, 0 1,
1 1)). Ascoordenadas devem estar no CRS da solicitacdo GetMap/GetPrint.

« HIGHLIGHT_LABELBUFFERCOLOR: Esse parametro controla o rétulo da cor do buffer.
« HIGHLIGHT_LABELBUFFERSIZE: Esse parametro controla o rétulo do tamanho do buffer.
¢« HIGHLIGHT_LABELCOLOR: Esse parimetro controla a cor do rétulo.

¢« HIGHLIGHT_LABEL_DISTANCE: controla a distincia entre os recursos (e.g. ponto ou linha) e o rétulo
em mm

« HIGHLIGHT_LABELFONT: Esse pardmetro controla a fonte do rétulo (e.g. Arial)

¢ HIGHLIGHT_LABEL_HORIZONTAL_ALIGNMENT: posiciona horizontalmente o rétulo em um
ponto usando o alinhamento especificado (e.g. ‘left’, ‘center’, ‘right’)

 HIGHLIGHT_LABEL_ROTATION: controla a rotacdo do rétulo em graus.
« HIGHLIGHT_LABELSIZE: Esse parimetro controla o tamanho do rétulo.
¢« HIGHLIGHT_LABELSTRING: Vocé pode passar o seu rotulamento de texto para esse parimetro

e HIGHLIGHT_LABEL_VERTICAL_ALIGNMENT: posiciona o rétulo verticalmente em um ponto us-
ando o alinhamento especifico (e.g. ‘top’, ‘half’, ‘bottom’)
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« HIGHLIGHT_SYMBOL.: Isso controla como a geometria ¢ tirada da linha e vocé pode mudar a largura do
contorno, cor e opacidade.

3.3 Web Feature Service (WFS)

The 1.0.0 and 1.1.0 WES standards implemented in QGIS Server provide a HTTP interface to query geographic
features from a QGIS project. A typical WFS request defines the QGIS project to use and the layer to query.

Documento de especificagdes de acordo com o nimero da versao do servico:
* WES 1.0.0
* WFS 1.1.0

Solicitacdes padrdes providas pelo servidor do QGIS:

Solicitagéo Descrigcao

GetCapabilities Retorna metadados XML com informagdes sobre o servidor
GetFeature Retorna uma selecdo de feicoes

DescribeFeatureType — Retorna uma descri¢do dos tipos de caracteristicas e propriedades
Transaction Permite que feicdes sejam inseridas, atualizadas ou excluidas

3.3.1 GetCapabilities

Standard parameters for the GetCapabilities request according to the OGC WES 1.0.0 and 1.1.0 specifications:

Pardmetros Requerido Descricéo

SERVICE Sim Nome do servico (WFS)
REQUEST Sim Nome do pedido (GetCapabilities)
VERSION Nao Versdo do servigo

Além dos padrdes, o QGIS Server suporta os seguintes parametros extras:

Parametros Requerido Descricao
MAP Sim arquivo de projeto QGIS

VERSION
Este pardmetro permite especificar a versdo do servico a ser utilizada. Os valores disponiveis para o pardmetro
VERSAO sdo:
«1.0.0
«1.1.0
Se nenhuma versdo for indicada na solicita¢dio, 1. 1. 0 serd usado por padrdo.

Exemplo de URL:

http://localhost/qggisserver?
SERVICE=WFS

&VERSION=1.1.0

&...

64 Capitulo 3. Servigos


https://portal.ogc.org/files/?artifact_id=7176
https://portal.ogc.org/files/?artifact_id=8339

QGIS Server 3.40 User Guide

3.3.2 GetFeature

Parametros padrio para a solicitacio GetFeature de acordo com as especificacdes OGC WFS 1.0.0e 1.1.0:

Paréametros Requerido  Descrigcao

SERVICE Sim Nome do servico (WES)

REQUEST Sim Nome da requisi¢do (GetFeature)
VERSION Nao Versao do servico

TYPENAME Nao Nome das camadas

FEATUREID Nao Filtrar as feicdes por ids
OUTPUTFORMAT Nao Formato de Saida

RESULTTYPE Nio Tipo do resultado

PROPERTYNAME  Nio Nome das propriedades a serem retornadas
MAXFEATURES Nao Numero médximo de fei¢des a serem retornadas
SRSNAME Nao Sistema de referéncia de coordenadas
FILTER Nao Codificacdo de filtros OGC

BBOX Nao Extensdao do Mapa

SORTBY Nio Classificar os resultados

Além dos padrdes, o QGIS Server suporta os seguintes pardmetros extras:

Parametros Requerido  Descrigcao

MAP Sim arquivo de projeto QGIS
STARTINDEX Nao Paginacdo

GEOMETRYNAME Nao Tipo de geometria para retornar
EXP_FILTER Nao Filtragem de expressdao

TYPENAME

Este parametro permite especificar nomes de camadas e € obrigatério se ID DA FEICAO ndo estiver definido.

Exemplo de URL:

http://localhost/ggisserver?
SERVICE=WFS

&VERSION=1.1.0

&REQU =GetFeature
&TYPENAME=countries

FEATUREID

Este parimetro permite especificar a identificacio de uma caracteristica especifica e é formado como " type-
name.fid,typename.fid,... .

Exemplo de URL:

http://localhost/ggisserver?
SERVICE=WFS

&REQUEST=GetFeature
&FEATUREID=countries.0,places.1

Resposta em XML.:
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<wfs:FeatureCollection xmlns:wfs="http://www.opengis.net/wfs" xmlns:ogc="http://
—WWW.opengis.net/ogc" xmlns:gml="http://www.opengis.net/gml" xmlns:ows="http://
—www.opengis.net/ows" xmlns:xlink="http://www.w3.0rg/1999/x1link" xmlns:ggs="http:/
—/www.qgis.org/gml" xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"._
—xsi:schemalLocation="http://www.opengis.net/wfs http://schemas.opengis.net/wfs/1.
—1.0/wfs.xsd http://www.qggis.org/gml http://192.168.1.15/ggisserver?SERVICE=WFS&
—VERSION=1.1.0&REQUEST=DescribeFeatureType&TYPENAME=countries, placesé&
—OUTPUTFORMAT=text/xml; subtype%3Dgml/3.1.1">

<gml :boundedBy>

</gml :boundedBy>
<gml: featureMember>
<ggs:countries gml:id="countries.1">

</qgs:countries>
</gml: featureMember>
<gml : featureMember>
<ggs:places gml:id="places.1">

</qggs:places>
</gml: featureMember>
</wfs:FeatureCollection>

OUTPUTFORMAT
Este parametro pode ser usado para especificar o formato da resposta. Se “VERSAQ” for maior ou igual a “1.1.0”,
GML3 € o formato padrio. Caso contrério, € utilizado GML2.
Os valores disponiveis sdo:

e gml2

e texto/xml; subtipo=gml/2.1.2

e gml3

e texto/xml; subtipo=gml/3.1.1

* geojson

* application/vnd.geo+Jjson,

e application/vnd.geo json

* application/geo+json

* application/geo json

* application/json

Exemplo de URL:

http://localhost/ggisserver?
SERVICE=WFS
&REQUEST=GetFeature
&FEATUREID=countries.0
&OUTPUTFORMAT=geojson

Resposta de GeoJSON:

{
"type":"FeatureCollection",
"bbox" : [
-180,

(continua na préxima pagina)

66 Capitulo 3. Servigos




QGIS Server 3.40 User Guide

(continuac@o da pégina anterior)
-90,
180,
83.6236
1,
"features": |
{
"bbox" : [
-61.891113,
16.989719,
-61.666389,
17.724998
] 4
"geometry": {
"coordinates": [
1,
"type":"MultiPolygon"
} r
"id":"countries.1",
"properties":{
"id":1,
"name" : "Antigua and Barbuda"
} 4
"type":"Feature"

RESULTTYPE

Este parametro pode ser usado para especificar o tipo de resultado a ser retornado. Os valores disponiveis sdo:
* resultados: o comportamento padrio
e “acertos”: retorna apenas uma contagem de recursos

Exemplo de URL:

http://localhost/ggisserver?
SERVICE=WFS

&VERSION=1.1.0
&REQUEST=GetFeature
&RESULTTYPE=hits

&...

PROPERTYNAME

This parameter may be used to specify a specific property to return. A property needs to be mapped with a TYPE—
NAME or a FEATUREID:

Exemplo de URL vilido:

http://localhost/ggisserver?
SERVICE=WFS
&REQUEST=GetFeature
&§PROPERTYNAME=name
&TYPENAME=places

Pelo contrario, a préxima URL retornard uma excegao:
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http://localhost/ggisserver?
SERVICE=WES
&REQUEST=GetFeature
&PROPERTYNAME=name
&TYPENAME=places, countries

<ServiceExceptionReport xmlns="http://www.opengis.net/ogc" version="1.2.0">

<ServiceException code="RequestNotWellFormed">There has to be a 1:1 mapping.
—between each element in a TYPENAME and the PROPERTYNAME list</ServiceException>
</ServiceExceptionReport>

MAXFEATURES

Este parametro permite limitar o nimero de feicdes devolvidas pelo pedido.

Exemplo de URL:

http://localhost/ggisserver?
SERVICE=WES
&REQUEST=GetFeature
&TYPENAME=places
&MAXFEATURES=1000

Nota: Este parametro pode ser util para melhorar o desempenho quando as camadas vetoriais subjacentes sdo
pesadas.

SRSNAME

This parameter allows to indicate the response output Spatial Reference System as well as the BBOX CRS and has to
be formed like EPSG : XXXX.

Exemplo de URL:

http://localhost/ggisserver?
SERVICE=WFS
&REQUEST=GetFeature
&TYPENAME=places
&SRSNAME=EPSG:32620

FILTER

This parameter allows to filter the response with the Filter Encoding language defined by the OGC Filter Encoding
standard. For example:

http://localhost/ggisserver?

SERVICE=WFS&

REQUEST=GetFeatureé&

TYPENAME=placesé&

FILTER=<Filter><PropertyIsEqualTo><PropertyName>name</PropertyName><Literal>Paris</
—Literal></PropertyIsEqualTo></Filter>

In case of multiple typenames, filters have to be enclosed in parentheses:
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http://localhost/ggisserver?

SERVICE=WES

&REQUEST=GetFeature

&TYPENAME=places, countries

&FILTER= (<Filter><PropertyIsEqualTo><PropertyName>name</PropertyName><Literal>Paris
—</Literal></PropertyIsEqualTo></Filter>) (<Filter><PropertyIsEqualTo>
—<PropertyName>name</PropertyName><Literal>France</Literal></PropertyIsEqualTo></
—Filter>)

Filter features that intersect with a polygon:

http://localhost/ggisserver?
SERVICE=WFS
&REQUEST=GetFeature
&VERSION=1.1.0
&TYPENAME=places
&FILTER=<Filter xmlns="http://www.opengis.net/ogc">
<Intersects>
<PropertyName>geometry</PropertyName>
<Polygon xmlns="http://www.opengis.net/gml" srsName="EPSG:4326">
<exterior>
<LinearRing>
<posList>
-0.6389 42.5922
10.2683 51.9106
14.5196 41.0320
-0.6389 42.5922
</posList>
</LinearRing>
</exterior>
</Polygon>
</Intersects>
</Filter>

BBOX

Este parametro permite especificar a extensdo do mapa com unidades de acordo com o SRC atual. As coordenadas
devem ser separadas por virgula.

The SRSNAME parameter may specify the CRS of the extent. If not specified, the CRS of the layer is used.
Exemplo de URL:

http://localhost/ggisserver?
SERVICE=WFS
&REQUEST=GetFeature
&TYPENAME=places
&BBOX=-11.84,42.53,8.46,50.98

The FEATUREID parameter cannot be used with the BBOX. Any attempt will result in an exception:

<ServiceExceptionReport xmlns="http://www.opengis.net/ogc" version="1.2.0">

<ServiceException code="RequestNotWellFormed">FEATUREID FILTER and BBOX.
—parameters are mutually exclusive</ServiceException>
</ServiceExceptionReport>
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SORTBY
Este parametro permite ordenar as caracteristicas resultantes de acordo com os valores de propriedade e deve ser
formado como nomPropriedade REGRA DE ORGANIZAGAO.
Valores disponiveis para REGRA DE ORGANIZAGAO em caso de triagem descendente:
D
e +D
e DESC
e +DESC
Valores disponiveis para REGRA DE ORGANIZACAO em caso de triagem ascendente:
e A
° +A
e ASC
e +ASC
Exemplo de URL:

http://localhost/ggisserver?
SERVICE=WFS
SREQUEST=GetFeature
&TYPENAME=places
&PROPERTYNAME=name
&MAXFEATURES=3

&SORTBY=name DESC

O resultado correspondente:

<wfs:FeatureCollection xmlns:wfs="http://www.opengis.net/wfs" xmlns:ogc="http://
—www.opengis.net/ogc" xmlns:gml="http://www.opengis.net/gml" xmlns:ows="http://
—www.opengis.net/ows" xmlns:xlink="http://www.w3.0rg/1999/x1link" xmlns:ggs="http:/
—/www.qggis.org/gml" xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance".
—xsi:schemalocation="http://www.opengis.net/wfs http://schemas.opengis.net/wfs/1.
—1.0/wfs.xsd http://www.ggis.org/gml http://192.168.1.15/gqgisserver?SERVICE=WFS&
—VERSION=1.1.0&REQUEST=DescribeFeatureType&TYPENAME=places&OUTPUTFORMAT=text/xml; .
—subtype%3Dgml/3.1.1">

<gml :boundedBy>

</gml :boundedBy>
<gml: featureMember>
<ggs:places gml:id="places.90">
<qgs :name>Zagreb</ggs :name>
</qgs:places>
</gml: featureMember>
<gml: featureMember>
<ggs:places gml:id="places.113">
<ggs :name>Yerevan</qgs :name>
</ggs:places>
</gml: featureMember>
<gml : featureMember>
<qgs:places gml:id="places.111">
<ggs :name>Yaounde</ggs : name>
</qgs:places>
</gml: featureMember>
</wfs:FeatureCollection>
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GEOMETRYNAME
Este pardmetro pode ser usado para especificar o tipo de geometria a ser retornada para as feicdes. Os valores
disponiveis sdo:

* extent

e centroid

* none

Exemplo de URL:

http://localhost/ggisserver?
SERVICE=WFS

&VERSTON=1.1.0
&REQUEST=GetFeature
&GEOMETRYNAME=centroid

&o oo

STARTINDEX

Este parametro é padrio no WFS 2.0, mas é uma extensio para o WFS 1.0.0.

Na verdade, ele pode ser utilizado para pular algumas caracteristicas no conjunto de resultados e, em combinacdo
com “MAXFEICOES”, ele fornece a capacidade de paginar através de resultados.

Exemplo de URL:

http://localhost/ggisserver?
SERVICE=WFS

&VERSTON=1.1.0
&REQUEST=GetFeature
&STARTINDEX=2

&o oo

EXP_FILTER

This parameter allows to filter the response with QGIS expressions. The ; character is used to separate filters in case
of multiple typenames.

Exemplo de URL:

http://localhost/ggisserver?

SERVICE=WFS

&REQUEST=GetFeature

&TYPENAME=places, countries
&EXP_FILTER="name"='Paris'; "name"='France'

3.3.3 DescribeFeatureType

Standard parameters for the DescribeFeatureType request according to the OGC WFS 1.0.0 and 1.1.0 specifica-
tions:
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Parametros Requerido  Descricao

SERVICE Sim Nome do servigo (WFS)

REQUEST Sim Name of the request (DescribeFeatureType)
VERSION Nao Versdo do servigo

OUTPUTFORMAT Nao Formato da resposta

TYPENAME Nio Nome das camadas

Além dos padrdes, o QGIS Server suporta os seguintes parametros extras:

Parametros Requerido Descricéo

MAP Sim arquivo de projeto QGIS

Exemplo de URL:

http://localhost/ggisserver?
SERVICE=WFS

&VERSION=1.1.0
&REQUEST=DescribeFeatureType
&TYPENAME=countries

Resposta de saida:

<schema xmlns:ogc="http://www.opengis.net/ogc" xmlns:xsd="http://www.w3.0rg/2001/
—XMLSchema" xmlns="http://www.w3.0rg/2001/XMLSchema" xmlns:qggs="http://www.qggis.
—org/gml" xmlns:gml="http://www.opengis.net/gml" targetNamespace="http://www.ggis.
—org/gml" version="1.0" elementFormDefault="qualified">
<import schemalocation="http://schemas.opengis.net/gml/3.1.1/base/gml.xsd".
—namespace="http://www.opengis.net/gml"/>
<element type="qggs:countriesType" substitutionGroup="gml:_Feature" name=
—"countries"/>
<complexType name="countriesType">
<complexContent>
<extension base="gml:AbstractFeatureType">
<sequence>
<element minOccurs="0" type="gml:MultiPolygonPropertyType" maxOccurs="1"_
—name="geometry"/>
<element type="long" name="id"/>
<element nillable="true" type="string" name="name"/>
</sequence>
</extension>
</complexContent>
</complexType>
</schema>

3.3.4 Transacao

Esta solicitagdo permite atualizar, apagar ou adicionar uma ou vdrias caracteristicas gracas a um documento XML.
A agfo deletar pode ser realizada com uma solicitagio POST, bem como com o parAmetro OPERACAO enquanto
que as operag0es adicionar e a atualizar podem ser realizadas apenas através de uma solicitacdo POST.

Pardmetros padrio para a solicitacdo da Transaco de acordo com as especificagdes OGC WFS 1.0.0 e 1.1.0:
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Parametros Requerido Descrigao

SERVICE Sim Nome do servigo (WFS)
REQUEST Sim Nome da solicita¢do (Transac¢ao)
VERSION Nao Versdo do servigo

FILTER Nio Codificaggo de filtros OGC
BBOX Nao Extensao do Mapa

FEATUREID Nio Filtrar as fei¢des por ids
TYPENAME  Nao Nome das camadas

Além dos padrdes, o QGIS Server suporta os seguintes parimetros extras:

Parametros Requerido Descri¢ao

MAP Sim arquivo de projeto QGIS
OPERATION  Niao Especifique a operacdo
EXP_FILTER Nio Filtragem de expressao

OPERACAO

Este parametro permite excluir um recurso sem utilizar um pedido POST com um documento XML dedicado.

Exemplo de URL:

http://localhost/ggisserver?
SERVICE=WFS

&VERSION=1.1.0
&REQUEST=Transaction
&OPERATION=DELETE
&FEATUREID=24

Nota: FEATUREID, BBOX and FILTER parameters are mutually exclusive and prioritized in this order.

Adicionar feicoes

Exemplo de solicitagdo de POST:

wget —-post-file=add.xml "http://localhost/ggisserver?SERVICE=WFS&
—REQUEST=Transaction"

com o documento adiciona.xml:

<?xml version="1.0" encoding="UTF-8"7?>
<wfs:Transaction service="WFS" version="1.0.0" xmlns:wfs="http://www.opengis.net/
—wfs" xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance" xmlns:ogc="http://www.
—opengis.net/ogc" xmlns="http://www.opengis.net/wfs" updateSequence="0"._
—xmlns:xlink="http://www.w3.0rg/1999/x1ink" xsi:schemaLocation="http://www.
—opengis.net/wfs http://schemas.opengis.net/wfs/1.0.0/WFS—capabilities.xsd"_
—xmlns:gml="http://www.opengis.net/gml" xmlns:ows="http://www.opengis.net/ows">
<wfs:Insert idgen="GenerateNew">
<ggs:places>
<ggs:geometry>

<gml:Point srsDimension="2" srsName="http://www.opengis.net/def/crs/EPSG/0/
—~4326">
." cs="," ts=" ">-4.6167,48.3833</

(continua na préxima pagina)

<gml:coordinates decimal="
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(continuac@o da pégina anterior)
—gml:coordinates>
</gml:Point>
</qgs:geometry>
<ggs:name>Locmaria-Plouzané</ggs:name>
</qgs:places>
</wfs:Insert>
</wfs:Transaction>

Atualizar feicoes

Exemplo de solicitacdo de POST:

wget —-post-file=update.xml "http://localhost/qgisserver?SERVICE=WFS&
REQUEST=Transaction"

com o documento atualiza.xml:

<?xml version="1.0" encoding="UTF-8"?>
<wfs:Transaction service="WFS" version="1.0.0" xmlns:wfs="http://www.opengis.net/
—wfs" xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance" xmlns:ogc="http://www.
—opengis.net/ogc" xmlns="http://www.opengis.net/wfs" updateSequence="0"_
—xmlns:xlink="http://www.w3.0rg/1999/x1ink" xsi:schemalocation="http://www.
—opengis.net/wfs http://schemas.opengis.net/wfs/1.0.0/WFS—capabilities.xsd"._
—xmlns:gml="http://www.opengis.net/gml" xmlns:ows="http://www.opengis.net/ows">
<wfs:Update typeName="places">
<wfs:Property>
<wfs:Name>name</wfs :Name>
<wfs:Value>Lutece</wfs:Value>
</wfs:Property>
<ogc:Filter>
<ogc:FeaturelId fid="24"/>
</ogc:Filter>
</wfs:Update>
</wfs:Transaction>

Excluir feicoes

Exemplo de solicitacdo de POST:

wget —-post-file=delete.xml "http://localhost/ggisserver?SERVICE=WFS&
—~REQUEST=Transaction"

com o documento deleta.xml:

<?xml version="1.0" encoding="UTF-8"?>
<wfs:Transaction service="WFS" version="1.0.0" xmlns:wfs="http://www.opengis.net/
—wfs" xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance" xmlns:ogc="http://www.
—opengis.net/ogc" xmlns="http://www.opengis.net/wfs" updateSequence="0"._
—xmlns:xlink="http://www.w3.0rg/1999/x1ink" xsi:schemalLocation="http://www.
—opengis.net/wfs http://schemas.opengis.net/wfs/1.0.0/WFS—capabilities.xsd"_
—xmlns:gml="http://www.opengis.net/gml" xmlns:ows="http://www.opengis.net/ows">
<wfs:Delete typeName="places">
<ogc:Filter>
<ogc:Featureld fid="24"/>
</ogc:Filter>
</wfs:Delete>
</wfs:Transaction>
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3.4 Web Coverage Service (WCS)

The 1.0.0 and 1.1.1 WCS standards implemented in QGIS Server provide a HTTP interface to access raster data,
referred to as coverage, coming from a QGIS project.

Especificacdes:
* WCS 1.0.0
* WCS 1.1.1

Solicitacdes padrdes providas pelo servidor do QGIS:

Solicitacao Descricao

GetCapadbilities Retorna metadados XML com informagdes sobre o servidor
DescribeCoverage — Retrieves XML document about additional information about coverages
GetCoverage Retrieves coverage

3.4.1 GetCapabilities

Standard parameters for the GetCapabilities request according to the OGC WCS 1.1.1 specifications:

Parametros Requerido Descricao

SERVICE Sim Name of the service (WCS)
REQUEST Sim Nome do pedido (GetCapabilities)
VERSION Nio Versdo do servigo

Além dos padrdes, o QGIS Server suporta os seguintes pardmetros extras:

Parametros Requerido Descrigéo
MAP Sim Arquivo de projeto QGIS

Exemplo de URL.:

http://localhost/ggisserver?
SERVICE=WCS

&VERSION=1.1.1
&REQUEST=GetCapabilities

XML document example when a single raster layer (named T20QPD_20171123T144719_TCI) is published in
the QGIS project for the WCS service:

<WCS_Capabilities xmlns="http://www.opengis.net/wcs" xmlns:xlink="http://www.w3.
—0rg/1999/x1ink" xmlns:gml="http://www.opengis.net/gml" xmlns:xsi="http://www.w3.
—org/2001/XMLSchema-instance" version="1.0.0" updateSequence="0"_
—xsi:schemalocation="http://www.opengis.net/wcs http://schemas.opengis.net/wcs/1.
—0.0/wcsCapabilities.xsd">

<Service>

</Service>
<Capability>

</Capability>
<ContentMetadata>
<CoverageOfferingBrief>
(continua na proxima pagina)
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(continuac@o da pégina anterior)

<name>T20QPD_20171123T144719_TCI</name>
<label>T20QPD_20171123T144719_TCI</label>
<lonLatEnvelope srsName="urn:ogc:def:crs:0GC:1.3:CRS84">
<gml:pos>-61.585973 16.331189</gml:pos>
<gml:pos>-61.52537 16.400376</gml:pos>
</lonLatEnvelope>
</CoverageOfferingBrief>
</ContentMetadata>
</WCS_Capabilities>

VERSION

Este parametro permite especificar a versdo do servigo a ser utilizada. Atualmente, os valores de versdo nio sio
usados internamente e sempre retornam para 1.1.1.

3.4.2 DescribeCoverage

This request allows to retrieve additional information about coverages like the format of the underlying datasource,
the number of bands, ... Standard parameters for the DescribeCoverage request according to the OGC WCS 1.1.1
specifications:

Pardmetros Requerido Descricao

SERVICE Sim Name of the service (WCS)

REQUEST Sim Name of the request (DescribeCoverage)
VERSION Nio Versdo do servigo

COVERAGE Nio Specify coverage layers (WCS 1.0.0)
IDENTIFIER Nio Especificar camadas de cobertura (WCS 1.1.1)

Além dos padrdes, o QGIS Server suporta os seguintes pardmetros extras:

Parametros Requerido Descricao
MAP Sim Arquivo de projeto QGIS

O documento XML para uma camada raster GeoTIFF de 3 bandas se parece com:

<CoverageDescription xmlns:xlink="http://www.w3.0rg/1999/x1ink" xmlns="http://www.
—opengis.net/wcs" xmlns:gml="http://www.opengis.net/gml" xmlns:xsi="http://www.w3.
—o0rg/2001/XMLSchema—-instance" updateSequence="0" version="1.0.0".
—xsi:schemalocation="http://www.opengis.net/wcs http://schemas.opengis.net/wcs/1.
—0.0/describeCoverage.xsd">
<CoverageOffering>
<name>T20QPD_20171123T144719_TCI</name>
<label>T20QPD_20171123T144719_TCI</label>
<lonLatEnvelope srsName="urn:ogc:def:crs:0GC:1.3:CRS84">

</lonLatEnvelope>
<domainSet>

</domainSet>
<rangeSet>
<RangeSet>
<name>Bands</name>
<label>Bands</label>
<axisDescription>
(continua na préxima pagina)
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(continuac@o da pégina anterior)
<AxisDescription>
<name>bands</name>
<label>bands</label>
<values>
<singleValue>1</singleValue>
<singleValue>2</singleValue>
<singleValue>3</singleValue>
</values>
</AxisDescription>
</axisDescription>
</RangeSet>
</rangeSet>
<supportedCRSs>

</supportedCRSs>
<supportedFormats nativeFormat="raw binary">
<formats>GeoTIFF</formats>
</supportedFormats>
</CoverageOffering>
</CoverageDescription>

COBERTURA

Este pardmetro, definido no WCS 1.0. 0, permite especificar as camadas a serem consultadas por informacdes
adicionais. Os nomes devem ser separados por virgula.

In addition, QGIS Server introduced an option to select layers by its short name. The short name of a layer may be
configured through Properties » Metadata in layer menu. If the short name is defined, then it’s used by default instead
of the layer’s name:

http://localhost/ggisserver?

SERVICE=WCS

&REQUEST=DescribeCoverage
&COVERAGE=mylayerlname,mylayer2shortname

Nota: COVERAGE is mandatory if IDENTIFIER is not set.

IDENTIFICADOR

This parameter replaces the COVERAGE parameter in WCS 1. 1. 1. But QGIS Server does not filter according to
the VERSION parameter so IDENTIFIER and COVERAGE have the same effect.

Nota: IDENTIFIER is mandatory if COVERAGE is not set. If both IDENTIFIER and COVERAGE parameters
are defined, COVERAGE is always used in priority.
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3.4.3 GetCoverage

This request allows to retrieve the coverage according to specific constraints like the extent or the CRS. Standard
parameters for the DescribeCoverage request according to the OGC WCS 1.1.1 specifications:

Parametros Requerido Descricéo

SERVICE Sim Name of the service (WCS)

REQUEST Sim Name of the request (GetCoverage)

VERSION Nao Versao do servico

COVERAGE Nao Specify coverage layers (WCS 1.0.0)
IDENTIFIER Nio Especificar camadas de cobertura (WCS 1.1.1)
WIDTH Sim Largura da resposta em pixels

HEIGHT Sim Altura da resposta em pixels

BBOX Sim Extensdao do mapa em unidades SRC

CRS Sim Sistema de Referéncia de Coordenadas da extensdo
RESPONSE_CRS Nido Sistema de referéncia de coordenadas da resposta

Além dos padrdes, o QGIS Server suporta os seguintes parametros extras:

Parametros Requerido Descrigao
MAP Sim Arquivo de projeto QGIS

BBOX

This parameter allows to specify the map extent in the units of the current CRS. Coordinates have to be separated by
a comma. The BBOX parameter is formed like minx, miny, maxx, maxy.

Exemplo de URL:

http://localhost/ggisserver?
SERVICE=WCS

&REQUEST=GetCoverage
&IDENTIFIER=T20QPD_20171123T144719_TCI
&BBOX=647533,1805950, 660987,1813940
&CRS=EPSG:32620

CRS

This parameter allows to indicate the Spatial Reference System of the BBOX parameter and has to be formed like
EPSG: XXXX.

RESPONSE_CRS

This parameter allows to indicate the output response Spatial Reference System and has to be formed like
EPSG: XXXX. The CRS of the corresponding coverage layer is used by default.
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WIDTH

Este parametro permite especificar a largura em pixels da imagem de saida. A resoluc¢do da imagem de resposta
depende desse valor.

HEIGHT

Este parametro permite especificar a altura em pixels da imagem de saida. A resolucdo da imagem de resposta
depende desse valor.

Figura3.23: From left to right: WIDTH=20&HEIGHT=20, WIDTH=50&HEIGHT=50,
WIDTH=100&HEIGHT=100

3.5 Web Map Tile Service (WMTS)

The 1.0.0 WMTS standard implemented in QGIS Server provides a HTTP interface to request tiled map images
generated from a QGIS project. A typical WMTS request defined the QGIS project to use, some WMS parameters
like layers to render, as well as tile parameters.

Documento de especificagdes do servigo:
« WMTS 1.0.0

Solicitacdes padrdes providas pelo servidor do QGIS:

Solicitagao Descrigao

GetCapabilities  Retorna metadados XML com informacdes sobre o servidor
GetTile Retorna um mosaico
GetFeaturelnfo  Recupera dados (geometria e valores) para um local de pixel

3.5.1 GetCapabilities

Standard parameters for the GetCapabilities request according to the OGC WMTS 1.0.0 specifications:

Parametros Requerido Descricao

SERVICE Sim Name of the service (WMTS)
REQUEST Sim Nome do pedido (GetCapabilities)

Além dos padrées, o QGIS Server suporta os seguintes parametros extras:
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Parametros Requerido Descricao
MAP Sim arquivo de projeto QGIS

Exemplo de URL:

http://localhost/?

SERVICE=WMTS
&REQUEST=GetCapabilities
&MAP=/home/qgis/projects/world.qgs

3.5.2 GetTile

Standard parameters for the GetTile request according to the OGC WMTS 1.0.0 specifications:

Parametros Requerido  Descricao

SERVICE Sim Name of the service (WMTS)
REQUEST Sim Name of the request (GetTile)
LAYER Sim Identificador de camada
FORMAT Sim Output format of the tile
TILEMATRIXSET Sim Nome da piramide
TILEMATRIX Sim Meshing

TILEROW Sim Coordenada de linha na malha
TILECOL Sim Coordenada da coluna na malha

Além dos padrdes, o QGIS Server suporta os seguintes parametros extras:

Parametros Requerido Descricéo
MAP Sim arquivo de projeto QGIS

Exemplo de URL:

http://localhost/?

SERVICE=WMTS

&REQUEST=GetTile
&MAP=/home/qgis/projects/world.qgs

&L =mylayer
&FORMAT=image/png
&TILEMATRIXSET=EPSG:4326
&TILEROW=0

&TILECOL=0

FORMAT

Este parametro pode ser usado para especificar o formato da imagem do bloco. Os valores disponiveis sdo:
* Jpg
* jpeg
* image/Jjpeg
* image/png

Se o pardmetro FORMATO for diferente de um desses valores, entdo o formato padrdo PNG serd usado.
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TILEMATRIXSET

This parameter defines the CRS to use when computing the underlying pyramid. Format: EP SG : XXXX.

TILEMATRIX

This parameter allows to define the matrix to use for the output tile.

TILEROW

This parameter allows to select the row of the tile to get within the matrix.

TILECOL

This parameter allows to select the column of the tile to get within the matrix.

3.5.3 GetFeaturelnfo

Standard parameters for the GetFeatureInfo request according to the OGC WMTS 1.0.0 specification:

Parédmetros Requerido  Descricao

SERVICE Sim Name of the service (WMTS)
REQUEST Sim Nome do pedido (GetFeatureInfo)
LAYER Sim Identificador de camada
INFOFORMAT Niao Formato de saida

I Nao Coordenada X de um pixel

J Nao Coordenada Y de um pixel
TILEMATRIXSET  Sim Nome da piramide
TILEMATRIX Meshing

TILEROW Sim Coordenada de linha na malha
TILECOL Sim Coordenada da coluna na malha

Além dos padrdes, o QGIS Server suporta os seguintes parametros extras:

Parametros Requerido Descrigao

MAP Sim arquivo de projeto QGIS

Exemplo de URL:

http://localhost/?

SERVICE=WMTS
&REQUEST=GetFeatureInfo
&MAP=/home/qgis/projects/world.qgs
&LAYER=mylayer

& INFOFORMAT=image/html

&I=10

&J=5
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INFOFORMAT

Este parametro permite definir o formato de saida do resultado. Os valores disponiveis sdo:
e text/xml
e text/html
* text/plain
e application/vnd.ogc.gml

The default value is text /plain.

Este parametro permite definir a coordenada X do pixel para o qual queremos recuperar a informagdo subjacente.

J

Este parametro permite definir a coordenada Y do pixel para o qual queremos recuperar a informacdo subjacente.

3.6 Feicoes OGC API

OGC API Features (OAPIF) is the first implementation of the new generation of OGC protocols. It is described by
the OGC API - Features - Part 1: Core document.

The API can be reached on typical installations via http://localhost/ggisserver/wfs3.

Aqui estd um rdpido resumo informal das diferencas mais importantes entre o bem conhecido protocolo WES e a
OAPIF:

¢ OAPIF é baseado em uma API REST
* OAPIF deve seguir as OPENAPI especificacdes

* OAPIF supports multiple output formats but it does not dictate any (only GeoJSON and HTML are currently
available in QGIS OAPIF) and it uses content negotiation to determine which format is to be served to the
client

* JSON e HTML s@o cidaddos de primeira classe na OAPIF
* OAPIF ¢ autodocumentacdo (através do endpoint /api)

* OAPIF ¢ totalmente navegavel (através de links) e buscével

Importante: While the OGC API Features implementation in QGIS can make use of the MAP parameter to specify
the project file, no extra query parameters are allowed by the OPENAPI specification. For this reason it is strongly
recommended that MAP is not exposed in the URL and the project file is specified in the environment by other means
(i.e. setting QGIS_PROJECT_FILE in the environment through a web server rewrite rule).

Nota: The API endpoint provides comprehensive documentation of all supported parameters and output formats
of your service. The following paragraphs will only describe the most important ones.
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3.6.1 Representacao de recursos
The implementation of OGC API Features in QGIS Server currently supports the following resource representation
(output) formats:

« HTML

¢ JSON

The format that is actually served will depend on content negotiation, but a specific format can be explicitly requested
by appending a format specifier to the endpoints.

Supported format specifier extensions are:
* .Jjson
e .html

Additional format specifier aliases may be defined by specific endpoints:
e .openapi: alias for . json supported by the API endpoint

e .geojson: alias for . json supported by the Features and Feature endpoints

3.6.2 Endpoints

The API provides a list of endpoints that the clients can retrieve. The system is designed in such a way that every
response provides a set of links to navigate through all the provided resources.

Endpoints points provided by the QGIS implementation are:

Nome Caminho Descricao
Landing / General information about the service and provides links
Page to all available endpoints
Con- /conformidade Informagdes sobre a conformidade do servico com as
formi- normas
dade
API /api Full description of the endpoints provided by the service
and the returned documents structure
Cole¢des /colecdes List of all collections (i.e. ‘vector layers’) provided by the
service
Colecdo /collections/ Informagdes sobre uma cole¢do (nome, metadados, ex-
{collectionId} tensdo etc.)
Feicdes  /collections/ Lista das fei¢des fornecidas pela colecao
{collectionId}/items
Feicao /collections/ Informacdes sobre uma fei¢do tinica

{collectionId}/items/
{featureld}

Similar to WFS-T (transactional Web Feature Service), it is possible to add, update and delete features (CRUD). The
respective requests are described on “/api”.
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Landing Page
The main endpoint is the Landing Page. From that page it is possible to navigate to all the available service endpoints.
The Landing Page must provide links to

* the API definition (path /api link relations service—-desc and service-doc),

¢ the Conformance declaration (path /conformance, link relation conformance), and

* the Collections (path /collections, link relation data).

Landing page JSON

QGIS Server

Available services

o Feature collections
® WFS 3.0 conformance classes
* API definition

powered by QGIS Server
Figura3.24: P4gina principal do servidor OAPIF

API Definition

The API Definition is an OPENAPI-compliant description of the API provided by the service. In its HTML rep-
resentation it is a browsable page where all the endpoints and their response formats are accurately listed and docu-
mented. The path of this endpoint is /api.

The API definition provides a comprehensive and authoritative documentation of the service, including all supported
parameters and returned formats.

Nota: This endpoint is analogue to WFS’s GetCapabilities

Lista de colecoes

The collections endpoint provides a list of all the collections available in the service. Since the service “serves” a
single QGIS project the collections are the vector layers from the current project (if they were published as WFS in
the project properties). The path of this endpointis /collections/.

Landing page / Feature collections JSON

Collections

world
restricted

poweredby QGIS Server

Figura3.25: Server OAPIF collections list page
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Collection detail

While the collections endpoint does not provide detailed information about each available collection, that information
is available in the /collections/{collectionId} endpoints. Typical information includes the extent, a
description, CRSs and other metadata.

The HTML representation also provides a browsable map with the available features.

Landing page / Collections / world JSON

world +
Available CRSs

® http://www.opengis.net/def/crs/0GC/1.3/CRS84
* http://www.opengis.net/def/crs/EPSG/9.6.2/4326
® http://www.opengis.net/def/crs/EPSG/9.6.2/3857
* http://www.opengis.net/def/crs/EPSG/9.6.2/900913

Extent

West

-179.99999999999997
South

-90.0
East

Leaflet | @ OpenStreetMap contributors
180.0
North

83.62359600000008

powered by QGIS Server

Figura3.26: P4gina de detalhes da coleta do Servidor OAPIF

Lista de feicoes

This endpoint provides a list of all features in a collection knowing the collection ID. The path of this endpoint is
/collections/{collectionId}/items.

The HTML representation also provides a browsable map with the available features.

Nota: This endpoint is analogue to GetFeature in WES 1 and WFES 2.

3.6. Feicoes OGC API 85



QGIS Server 3.40 User Guide

Landing page / Collections / world / Features in layer world

Previous = Next

Features in layer world

world 20
AREA 845942
FIPS BR
1502 BR
1S03 BRA
LAT 10772
LON -53.089
NAME Brazil
POP2005 186830759
REGION 19
SUBREGION 5

UN 76

GEOJSON

Leaflet | © OpenStreetMap contributors

Figura3.27: Pagina de lista de recursos do servidor OAPIF

Detalhe da feicao

This endpoint provides all the available information about a single feature, including the feature attributes and its

geometry. The path of this endpointis /collections/{collectionId}/items/{itemId}.

The HTML representation also provides a browsable map with the feature geometry.

Landing page / Collections / world / Items of world / world - feature 20

world - feature 20

AREA
FIPS
Iso02
103

LAT

LON
NAME
POP2005
REGION
SUBREGION
UN

845942
BR

BR

BRA
-10.772
-53.089
Brazil
186830759
19

5

76

powered by QGIS Server

Colombia

GEOJSON

Venezuela

Argentina

Leaflet | & OpenStrestMap contributors

Figura3.28: P4gina de detalhes do servidor OAPIF
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3.6.3 Paginacao

Pagination of a long list of features is implemented in the OGC API through next and prev links, QGIS server
constructs these links by appending 1imit and offset as query string parameters.

Exemplo de URL:

[http://localhost/qgisserver/wfs3/collection_one/items.json?offsetziO&Limitle

Nota: The maximum acceptable value for limit can be configured with the
QGIS_SERVER_API_WFS3_MAX_LIMIT server configuration setting (see: Varidveis ambientais).

3.6.4 Filtragem de recursos

The features available in a collection can be filtered/searched by specifying one or more filters.

Filtro de data e hora

Collections with date and/or datetime attributes can be filtered by specifying a datet ime argument in the query
string. By default the first date/datetime field is used for filtering. This behavior can be configured by setting a “Date”
or “Time” dimension in the QGIS Server » Dimension section of the layer properties dialog.

The date and time filtering syntax is fully described in the API Definition and also supports ranges (begin and end
values are included) in addition to single values.

Exemplo de URL:

Returns only the features with date dimension matching 2019-01-01

[http://localhost/qgisserver/wfs3/collection_one/items.json?datetime=2019folfol

Returns only the features with datetime dimension matching 2019-01-01T01:01:01

http://localhost/qggisserver/wfs3/collection_one/items.json?datetime=2019-01-
—01T01:01:01

Returns only the features with datetime dimension in the range 2019-01-01T01:01:01 -
2019-01-01T12:00:00

http://localhost/qgisserver/wfs3/collection_one/items.json?datetime=2019-01—
—01T01:01:01/2019-01-01T12:00:00

Bounding box filter

A bounding box spatial filter can be specified with the bbox parameter:
A ordem dos elementos separados por virgula €é:

* Lower left corner, WGS 84 longitude

e Lower left corner, WGS 84 latitude

¢ Upper right corner, WGS 84 longitude

» Upper right corner, WGS 84 latitude
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Nota: The OGC specifications also allow a 6 item bbox specifier where the third and sixth items are the Z compo-
nents, this is not yet supported by QGIS server.

Exemplo de URL:

[http://localhost/qgisserver/wfs3/collection_one/items.json?bbox:—180,—90,180,90 }

If the CRS of the bounding box is not WGS 84, a different CRS can be specified by using the optional parameter
bbox—crs. The CRS format identifier must be in the OGC URI format:

Exemplo de URL:
http://localhost/qggisserver/wfs3/collection_one/items.json?bbox=913191,5606014,
—913234,56060298bbox—crs=http://www.opengis.net/def/crs/EPSG/9.6.2/3857

Filtros de atributos

Attribute filters can be combined with the bounding box filter and they are in the general form: <attribute
name>=<attribute value>. Multiple filters can be combined using the AND operator.

Exemplo de URL:

filters all features where attribute name equals “my value”

[http://localhost/qgisserver/wfs3/collection_one/items.json?attribute_one=my%20value }

Partial matches are also supported by using a * (“star”) operator:
Exemplo de URL:

filters all features where attribute name ends with “value”

[http://localhost/qgisserver/wfs3/collection_one/items.json?attribute_one:*value }

3.6.5 Feature sorting

It is possible to order the result set by field value using the sortby query parameter.

The results are sorted in ascending order by default. To sort the results in descending order, a boolean flag
(sortdesc) can be set:

[http://localhost/qgisserver/wfs3/collection_one/items.json?sortby:name&sortdesczl J

3.6.6 Selecao de atributo

The feature attributes returned by a Lista de feicdes call can be limited by adding a comma separated list of attribute
names in the optional properties query string argument.
Exemplo de URL:

retorna apenas o atributo nome

[http://localhost/qgisserver/wfs3/collection_one/items.json?properties:name J
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3.6.7 Personalizar as paginas HTML

The HTML representation uses a set of HTML templates to generate the response. The template is parsed by a
template engine called inja. The templates can be customized by overriding them (see: Substituicdo de modelos). The
template has access to the same data that are available to the JSON representation and a few additional functions are
available to the template:

Funcoes de modelo personalizado

* path_append( path ): appends a directory path to the current url
e path_chomp ( n ): removes the specified number “n” of directory components from the current url path
* json_dump ( ): prints the JSON data passed to the template

* static( path ): returns the full URL to the specified static path. For example: “static( “/style/black.css”
)” with a root path “http://localhost/qgisserver/wfs3” will return “http://localhost/qgisserver/wfs3/static/style/
black.css”.

e links_filter( links, key, wvalue ): Returns filtered links from a link list

e content_type_name ( content_type ): Returns a short name from a content type, for example
“text/html” will return “HTML”

e n12br ( texto ): Retorna o texto de entrada com todas as novas linhas substituidas por “<br>" tags

e starts_with( string, prefix ): returns true if a string begins with the provided string prefix,
false otherwise

Substituicao de modelos

Templates and static assets are stored in subdirectories of the QGIS server default API resource directory (/usr/
share/qggis/resources/server/api/ onaLinux system), the base directory can be customized by chang-
ing the environment variable QGIS_SERVER_API_RESOURCES_DIRECTORY.

A typical Linux installation will have the following directory tree:

/usr/share/qgis/resources/server/api/
L— ogc

— schema.json
— static
| — jsonFormatter.min.css
| — jsonFormatter.min.js
| L— style.css
L— templates

L— wfs3
describeCollection.html
describeCollections.html
footer.html
getApiDescription.html
getFeature.html
getFeatures.html
getLandingPage.html
getRequirementClasses.html
header.html
leaflet_map.html
links.html

[TTTTTTTTTT

J

To override the templates you can copy the whole tree to another location and point
QGIS_SERVER_API_RESOURCES_DIRECTORY to the new location.
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capituLo 4

Catalogo

The QGIS Server Catalog is a simple catalog that shows the list of QGIS projects served by the QGIS Server. It
provides a user-friendly fully browsable website with basic mapping capabilities to quickly browse the datasets ex-
posed through those QGIS projects. The catalog can be configured using the environment variables starting with
QGIS_SERVER_LANDING_PAGE (see Varidveis ambientais).

QGIS Server Catalog

A Test Project GECCO

Puetapata [Jerows Queranara  [Jarowse

Testing WMTS DOP and overlay

Harsd erafted with Wbyl Cocneratie

Figura4.1: Server Catalog project list page
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Vocé pode consultar os metadados associados a um projeto e os servigos que ele fornece. Links para esses servicos
também sdo fornecidos.

QGIS Server Catalog QGIS Server Catalog

ATest Project ATest Project

GENERAL SERVICES - ENERA SERVICES

OAPIF/WFSE
WFS GetCapabilities

WIS GetCapabiliies

Figura4.2: Server Catalog, metadata associated to a project and services (links to) that it provides.

By browsing a project, it is listed the dataset that it serves.

ared ot et by L s

Figura4.3: Browsing a dataset served by a project in the Server Catalog

Use o clique direito sobre uma camada para exibir a tabela de atributos associada a ela.

Hand crated it @byococpetae Hand crated it @yococperae

Figura4.4: Tabela de atributos associados a uma camada
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E possivel consultar as informacdes dos elementos do mapa, como mostrado na imagem abaixo:

blusmartls

[~

e

i crahd s P by L oo

Figura4.5: Consultando informacdes de um elemento do mapa
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CAPITULO D

Complementos

5.1 Lista de plugins

Plugins também podem ser instalados no Servidor QGIS.
Alguns plugins projetados para servidor podem ser encontrados no repositério oficial QGIS.

Instale apenas plugins que voc€ precisa para seu proprio propésito. No servidor QGIS, os plugins sdo como ganchos no
servidor QGIS, eles podem alterar entradas ou saidas do servidor QGIS. Eles podem produzir resultados inesperados
se vocé nio souber como o plugin funciona. Consulte a respectiva documentagio ou o aplicativo que precisa dos
plug-ins do servidor QGIS para saber qual plug-in pode ser util para vocé.

5.2 Localizacao dos plugins

Por padrio, nos sistemas baseados em Debian, QGIS Server ird verificar por plugins localizados em /usr/1ib/
qgis/plugins. O valor padrio exibido quando QGIS Server esté iniciando, nos logs. E possivel configurar
um caminho customizado através da alteracio da varidvel de ambiente QGIS_PLUGINPATH nas configuracdes do
servidor web.

5.3 Instalacao

5.3.1 Manualmente com um ZIP

Como exemplo, para instalar o plugin HelloWorld para testar o servidor, usando uma pasta especifica, primeiro é
necessdrio criar um diretdrio para manter os plugins do servidor. Isto serd especificado na configuracéo do host virtual
e passado para o servidor através de uma varidvel de ambiente:

mkdir -p /var/www/qggis—-server/plugins

cd /var/www/qgis—-server/plugins

wget https://github.com/elpaso/qgis-helloserver/archive/master.zip
unzip master.zip

mv ggis—-helloserver-master HelloServer
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Aviso: De acordo com sua descri¢io, o plugin HelloServer é projetado para fins de desenvolvimento e demon-
stracdo. Ndo mantenha este plugin em produgio se vocé nao precisar dele.

5.3.2 Com uma ferramenta de linha de comando

Se vocé precisar instalar e atualizar regularmente plugins que sdo armazenados no repositdrio de plugins QGIS, vocé
pode utilizar o QGIS-Plugin-Manager. E uma ferramenta para ajuda-lo a gerenciar os plugins a partir da linha de
comando.

A instalac@o estd usando pip. Instalar em um ambiente virtual € uma boa pratica, mas néo € obrigatério:

[pipS install ggis-plugin-manager }

Para atualizar a ferramenta:

[pipS install --upgrade ggis-plugin-manager }

Entdo, vocé pode utilizar o executdvel qgis-plugin-manager a partir da linha de comando:

cd /var/www/qgis—server/plugins

ggis-plugin-manager list

QGIS server version 3.19.0

List all plugins in /var/www/ggis—-server/plugins
o

| Folder |  Name |  Version | Experimental [—
—QGIS min | QGIS max | Author |  Action [
|wfsOutputExtension |wfsOutputExtension [1.6.2 | | 3.
-0 | |3Liz |
|qgis_server_render_geojson | GeoJson Renderer |v0.4 | | 3.
—4 | |[Matthias Kuhn (OPENGIS.ch) |

|[DataPlotly |Data Plotly |13.7.1 | | 3.
4 |3.98 |[Matteo Ghetta (Faunalia) |Upgrade to 3.8.1 |
o

Sugerimos que vocé leia a documentacdo completa no arquivo leiame para saber como instalar ou atualizar plugins
com esta ferramenta.

5.4 Configuracao do Servidor HTTP

5.4.1 Apache

Para poder usar plugins de servidor, FastCGI precisa saber onde procurar. Portanto, temos que modificar o arquivo
de configuragdo do Apache para indicar a varidvel de ambiente QGIS_PLUGINPATH para FastCGI:

[chidInitialEnv QGIS_PLUGINPATH "/var/www/ggis—-server/plugins" }

Além disso, uma autorizagio HTTP baésica € necessaria para jogar com o plugin HelloWorld introduzido anterior-
mente. Portanto, temos que atualizar o arquivo de configuracdo do Apache uma tltima vez:
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# Needed for QGIS HelloServer plugin HTTP BASIC auth
<IfModule mod_fcgid.c>

RewriteEngine on

RewriteCond %${HTTP:Authorization}

RewriteRule .* - [E=HTTP_AUTHORIZATION:%{HTTP:Authorization}]
</IfModule>

Em seguida, reinicie o Apache:

[systemctl restart apache2

5.5 Como usar um plug-in

Teste o servidor com o plugin HelloWorld:

wget —gq -O - "http://localhost/cgi-bin/ggis_mapserv.fcgi?SERVICE=HELLO"
HelloServer!

Vocé pode dar uma olhada no padrdo GetCapabilities do QGIS Server em:

http://localhost/cgi-bin/ggis_mapserv.fcgi?SERVICE=WMS&VERSION=1.3.0&
—REQUEST=GetCapabilities

5.5. Como usar um plug-in
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CAPITULO O

Configuracdo avangada

6.1 Registrando

To log requests sent to the server, you have to set the following environment variable:

* QGIS_SERVER_LOG_STDERR

With the following variables the logging can be further customized:

* OGIS_SERVER_LOG_LEVEL

* QGIS_SERVER_LOG_PROFILE

6.2 Variaveis ambientais

Vocé pode configurar alguns aspectos do QGIS Server configurando environment variables.

According to the HTTP server and how you run QGIS Server, there are several ways to define these variables. This
is fully described in Servidor HTTP Apache.

Nome

Descricao

Padrdo Servicos

QGIS_OPTIONS_PATH

QGIS_PLUGINPATH

Specifies the path to the directory with
settings. It works the same way as
QGIS application —--optionspath
option. It is looking for settings file in
<QGIS_OPTIONS_PATH>/QGIS/
OGIS3.ini.

Useful if you are using Python plugins
for the server, this sets the folder that is
searched for Python plugins.

13

Tudo

Tudo

continua na proxima pagina
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Tabela 6.1 - continuagéo da pagina anterior

Nome

Descricao

Padrao

Servicos

QGIS_PROJECT_FILE

QGIS_SERVER_ALLOWED_E

QGIS_SERVER_API_RESOUR

QGIS_SERVER_APPLICATIO

QGIS_SERVER_API_WFS3_M
QGIS_SERVER_CACHE_DIRI
QGIS_SERVER_CACHE_SIZE
QGIS_SERVER_CAPABILITIE

QGIS_SERVER_DISABLE_GE

QGIS_SERVER_FORCE_REA]

QGIS_SERVER_IGNORE_BAI

QGIS_SERVER_LANDING_P/

QGIS_SERVER_LANDING_P/

QGIS_SERVER_LANDING_P/

The .ggs or .qggz project file, normally
passed as a parameter in the query string
(with MAP), you can also set it as an en-
vironment variable (for example by using
mod_rewrite Apache module).

Note that you may also indicate a
project stored in PostgreSQL, e.g.
postgresqgl://localhost:54327

sslmode=disable&dbname=mydbé&s:

or inside a geopackage file,
geopackage: /path/to/
geopackage/file.gpkg?
projectName=myProjectName.
Comma separated list of strings that repre-
sent the allowed extra SQL tokens accepted
as components of a feature filter.

Diretério base para todos os recursos estati-
cos OGC API (tais como OAPIF/WES3)
(modelos HTML, CSS, JS, ...)

Name of the application to be used, for
instance when connecting to a database to
identify the QGIS server instance connected
Maximum value for limit in a
OAPIF/WEFS3 features request.

Specifies the network cache directory on the
filesystem.

e.g.

Sets the network cache size in MB.

The maximum number of project capabili-
ties to cache.

Esta é uma op¢do no nivel do projeto para
melhorar o tempo de leitura do projeto de-
sativando o carregamento de layouts.
Activating this option disables the QGIS
WMS GetPrint request. Set this QGIS
project flag to not load layouts.

Force QGIS Server to open all layers in a
read only mode

“Bad” layers are layers that cannot be
loaded. The default behavior of QGIS
Server is to consider the project as not avail-
able if it contains a bad layer.

The default behavior can be overridden by
setting this variable to 1 or true. In
this case, “bad” layers will just be ignored,
and the project will be considered valid and
available.

Prefixo do componente do caminho da URL
base da pagina inicial

Directories used by the landing page service
to find .qgs and .qgz projects

PostgreSQL connection strings used by the
landing page service to find projects

3]

depende do

pacote

QGIS3 server

10000

cache

in profile
directory

50 MB

40

falso

falso

falso

132
23

132

Tudo

WMS

OAPIF/WES3

Tudo

OAPIF/WEFES3

Tudo

Tudo

Tudo

WMS

Tudo

Tudo

Tudo

Tudo

Tudo

continua na proxima pagina
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Tabela 6.1 - continuagéo da pagina anterior

Nome Descricao Padréo Servigos
QGIS_SERVER_LOG_FILE  Especificar o caminho e o nome do arquivo. Tudo
Certifique-se de que o servidor tenha as
permissdes adequadas para gravar no ar-
quivo. O arquivo deve ser criado automati-
camente, basta enviar algumas requisi¢des
para o servidor. Se ndo estiver 14, verifique
as permissdes.
iso:
GIS_SERVER_LOG_FILE
dep-
rd-
cated
sihce
GIS
34,
use
GIS_SERVER_LOG_STDERR
id-
stead.
Fjle
Idg-
gmng
sup-
port
ill
oved
GIS
410.
Especifique o nivel de log desejado. Os val- 0 Tudo
QGIS_SERVER_LOG_LEVEL ores disponiveis sdo:
* 0 ou INFO (registrar todas as solici-
tacdes)
* 1 Ou ALERTA
e 2 or CRITICAL (log just critical
errors, suitable for production pur-
poses)
Add  detailed profile  information falso Tudo
QGIS_SERVER_LOG_PROFIL to the logs, only effective when
QGIS_SERVER_LOG_LEVEL=0
Activate logging to stderr. This falso Tudo

QGIS_SERVER_LOG_STDERI variable has no effect when
QGIS_SERVER_LOG_FILE is set.
¢ 0 ou falso (ndo diferencia maits-
culas de mindsculas)
¢ 0 ou verdadeiro (ndo diferencia
maiusculas de minisculas)

continua na proxima pagina
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Tabela 6.1 - continuagéo da pagina anterior

Nome

Descricao

QGIS_SERVER_MAX_ THREA

QGIS_SERVER_OVERRIDE_£

QGIS_SERVER_PARALLEL_}

QGIS_SERVER_PROJECT_CA

QGIS_SERVER_PROJECT_CA

Number of threads to use when parallel ren-
dering is activated. If value is —1 it uses the
number of processor cores.
Sets LOCALE to be used by QGIS server.
The default value is empty (no override).
Example: de_CH.ut£f8
Activates parallel rendering for WMS
GetMap requests. It’s disabled (false) by
default. Available values are:
e 0 ou falso (ndo diferencia maits-
culas de mintsculas)
¢ 0 ou verdadeiro (nao diferencia
maitsculas de mindsculas)

Controls the periodic strategy interval for
cache invalidation, in milliseconds. De-
faults to O which selects the legacy File sys-
tem watcher.
Defines method for invalidating the project
cache. Available strategies are:
 filesystem: uses the file system
watcher strategy
e periodic: uses the last modi-
fied value of a project for check-
ing changes on project configuration.
Convenient on atypical file systems,
such as NFS, or when the project file
is stored in a database system like
PostgreSQL.
e of f: disables internal cache invali-
dation completely

Padrao Servicos

-1 Tudo

© Tudo

falso WMS
Tudo

filesystem Tudo

continua na proxima pagina
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Tabela 6.1 - continuagéo da pagina anterior

Nome Descricao Padréo Servigos
This is an option to set the service URL if © Tudo
QGIS_SERVER_SERVICE_UR it is not present in the project.
The service URL is defined from (in order
of precedence):
 Value defined in the project per ser-
vice
e The
QGIS_SERVER_<service>_SER
environment variable
e The
QGIS_SERVER_SERVICE_URL
environment variable
e The
X-Qgis—-<service>-Service-—
header
e The X-Qgis-Service-Url
header
¢ Build from the Forwarded header
* Build from the
X-Forwarded-Host and
X-Forwarded-Proto head-
ers
¢ Build from the Host header and the
server protocol
* Build from the server name and the
server protocol.
In the last four cases, the resulting Service
URL is based on the MAP parameter pro-
vided in the query string and on the incom-
ing path request.
QGIS_SERVER_SHOW_GROU Defines whether a group separator (e.g. falso WMS
thousand separator) should be used for nu-
meric values (e.g. in GetFeaturelnfo re-
sponses). The default value is 0.
e 0 ou falso (ndo diferencia maits-
culas de minusculas)
¢ 0 ou verdadeiro (ndo diferencia
maitsculas de mindsculas)
QGIS_SERVER_TRUST_LAYI This is an option at the project level to falso Tudo

improve project read time by using the
vector layer extents defined in the project
metadata and disabling the check for Post-
greSQL/PostGIS layer primary key unique-
ness.

Trusting layer metadata can be forced by
setting this variable to 1 or t rue. The vec-
tor layer’s extent will then be the one defined
in the project, and the PostgreSQL/PostGIS
layer’s primary key defined in the data
source is considered as unique without a
check.

Do not use it if layers’ extent is not fixed
during the project’s use.

continua na proxima pagina
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Tabela 6.1 - continuagéo da pagina anterior
Nome Descricao Padréo Servigos

QGIS_SERVER_WCS_SERVIC This is an option to set the service URL ° WCS
if it is not present in the project. See
OGIS_SERVER _SERVICE_URL for more
information.

QGIS_SERVER_WFS_SERVIC This is an option to set the service URL ° WES
if it is not present in the project. See
QGIS_SERVER_SERVICE_URL for more

information.
QGIS_SERVER_WMS_MAX_1 Maximum height/width fora WMS request. -1 WMS
/ The most conservative between this and the

QGIS_SERVER_WMS_MAX ' project one is used. If the value is -1, it
means that there is no maximum set.
QGIS_SERVER_WMS_SERVI( This is an option to set the service URL ° WMS
if it is not present in the project. See
OGIS_SERVER_SERVICE_URL for more
information.
QGIS_SERVER_WMTS_SERV This is an option to set the service URL © WMTS
if it is not present in the project. See
OGIS_SERVER _SERVICE_URL for more
information.
QUERY_STRING The query string, normally passed by the © Tudo
web server. This variable can be useful
while testing QGIS server binary from the
command line.
For example for testing a GetCapabilities
request on the command line to a project
that also requires a PostgreSQL connection
defined in a pg_service.conf file:

PGSERVICEFILE=/etc/pg_service.
—conf \

QUERY_STRING="MAP=/home/
—projects/world.qggsé
—SERVICE=WMS&
—REQUEST=GetCapabilities" \
/usr/lib/cgi-bin/ggis_mapserv.
—fcgi

The result should be either the content of the

GetCapabilities response or, if something is

wrong, an error message.

6.3 Settings summary

When QGIS Server is starting, you have a summary of all configurable parameters thanks to environment variables.
Moreover, the value currently used and the origin is also displayed.

Por exemplo com spawn-fcgi:

S_OPTIONS_PATH=/home/user/.local/share/QGIS/QGIS3/profiles/default/
export O ERVER_LOG_STDERR=1

export QGIS_SERVER_LOG_LEVEL=2

spawn-fcgi -f /usr/lib/cgi-bin/qgis_mapserv.fcgi -s /tmp/ggisserver.sock -U www-—
—~data -G www-data —-n

export OC

QGIS Server Settings:
(continua na préxima pagina)
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(continuac@o da pégina anterior)

— QGIS_OPTIONS_PATH / '' (Override the default path for user configuration): '/
—home/user/.local/share/QGIS/QGIS3/profiles/default/' (read from ENVIRONMENT_
—VARIABLE)

— QGIS_SERVER_PARALLEL_RENDERING / '/qggis/parallel_rendering' (Activate/
—Deactivate parallel rendering for WMS getMap request): 'true' (read from INI_

—FILE)

— QGIS_SERVER_MAX_ THREADS / '/ggis/max_threads' (Number of threads to use when.

—parallel rendering is activated): '4' (read from INI_FILE)
— QGIS_SERVER_LOG_LEVEL / '' (Log level): '2' (read from ENVIRONMENT_VARIABLE)
- QGIS_SERVER_LOG_STDERR / '' (Activate/Deactivate logging to stderr): '1'.

— (read from ENVIRONMENT_VARIABLE)
— QGIS_PROJECT_FILE / '' (QGIS project file): '' (read from DEFAULT_VALUE)

— MAX_CACHE_LAYERS / '' (Specify the maximum number of cached layers): '100'._
— (read from DEFAULT_VALUE)

— QGIS_SERVER_CACHE_DIRECTORY / '/cache/directory' (Specify the cache.
—directory): '/root/.local/share/QGIS/QGIS3/profiles/default/cache' (read from.
—DEFAULT_VALUE)

— QGIS_SERVER_CACHE_SIZE / '/cache/size' (Specify the cache size): '52428800'.
— (read from INI_FILE)

Ini file used to initialize settings: /home/user/.local/share/QGIS/QGIS3/profiles/
—default/QGIS/QGIS3.ini

In this particular case, we know that QGIS_SERVER_MAX_THREADS and
QGIS_SERVER_PARALLEL_RENDERING values are read from the ini file found in
QGIS_OPTIONS_PATH directory (which is defined through an environment variable). The corresponding
entries in the ini file are /qgis/max_threads and /qgis/parallel_rendering and their values are true and 4 threads.

6.4 Connection to service file

In order to make apache aware of the PostgreSQL service file (see the pg-service-file section) you need to make your
* . conf file look like:

SetEnv PGSERVICEFILE /home/web/.pg_service.conf

<Directory "/home/web/apps2/bin/">
AllowOverride None
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6.5 Adicione fontes ao seu servidor linux

Tenha em mente que voc€ pode usar projetos QGIS que apontam para fontes que podem ndo existir por padrdo em
outras maquinas. Isso significa que se voc€ compartilhar o projeto, ele podera parecer diferente em outras maquinas
(se as fontes ndo existirem na maquina de destino).

Para garantir que isso ndo aconteca, vocé sé precisa instalar as fontes ausentes na maquina de destino. Fazer isso em
sistemas desktop geralmente € trivial (clique duas vezes nas fontes).

Para linux, se vocé ndo tiver um ambiente de desktop instalado (ou preferir a linha de comando), precisara:

On Debian based systems:

.

sudo su
mkdir -p /usr/local/share/fonts/truetype/myfonts && cd /usr/local/share/fonts/
—truetype/myfonts

# copy the fonts from their location
cp /fonts_location/*

chown root *
cd .. && fc-cache -f -v

On Fedora based systems:

-

sudo su
mkdir /usr/share/fonts/myfonts && cd /usr/share/fonts/myfonts

# copy the fonts from their location
cp /fonts_location/*

chown root *
cd .. && fc-cache -f -v
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CAPITULO /

Servidor de desenvolvimento

A production installation and deployment of QGIS Server usually involves setting up a web server component (e.g.
Apache or Nginx) that can forward the HTTP requests coming from the clients to the QGIS Server FastCGI binary

application.

If you want to quickly test QGIS Server on your local machine without configuring and installing a full web server
stack you can use the QGIS Development Standalone server.

Esta é uma aplicacdo independente que fornece um servidor web muito simples, pronto para servir seus arquivos de

projeto.

exposed server.

Aviso: The Standalone Development Server has not been developed with the purpose of being used in production,
it was not checked for security vulnerabilities or for other stress conditions that normally will occur on a publicly

Para lancar o servidor:

£$ gqgis_mapserver

A porta padrdo que o Servidor de Desenvolvimento escuta ¢ 8000. Exemplo de saida:

CTRL+C to exit

127.0.0.1 [lun gen 20 15:16
—qgis_server/test_project.
127.0.0.1 [lun gen 20 15:16
—Jjs HITP/1.1" 200

—css HTTP/1.1" 200
—" 200

127.0.0.1 [lun gen 20 15:16
—testdata/ggis_server/test

127.0.0.1 [lun gen 20 15:16:

127.0.0.1 [lun gen 20 15:16:

QOGIS Development Server listening on http://localhost:8000

:41 2020] 5140 103ms "GET /wfs3/?MAP=/tests/testdata/

qgs HITP/1.1" 200

:41 2020] 3298 2ms "GET /wfs3/static/jsonFormatter.min.

41 2020] 1678 3ms "GET /wfs3/static/jsonFormatter.min.

41 2020] 1310 5ms "GET /wfs3/static/style.css HTTP/1.1

243 2020] 4285 13ms "GET /wfs3/collections?MAP=/tests/

_project.qgs HTTP/1.1" 200

J

O servidor tem algumas opg¢oes que podem ser passadas como argumentos de linha de comando. Vocé pode vé-las

todas invocando o servidor com —h.
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Usage: ggis_mapserver [options] [address:port]
QGIS Development Server

Options:
=la, ==Ia@l®
-v, —-version

-1 <loglevel>

-p <projectPath>

Displays this help.
Displays version information.
Sets log level (default: 0)
0: INFO
1: WARNING
2: CRITICAL
Path to a QGIS project file (*.ggs or *.qgz),
if specified it will override the query string MAP argument
and the QGIS_PROJECT_FILE environment variable

Arguments:

addressAndPort Listen to address and port (default: "localhost:8000")
address and port can also be specified with the environment
variables QGIS_SERVER_ADDRESS and QGIS_SERVER_PORT
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CAPITULO 8

Containerized deployment

There are many ways to use containerized application, from the most simple (simple Docker images) to sophisticated
(Kubernetes and so on).

Nota: Este tipo de implantacdo precisa da aplica¢do docker para ser instalado e executado. Verifique este “tutorial
<https://www.docker.com/101-tutorial>>"_.

Dica: Docker run pre packaged application (aka images) which can be retrieved as sources (Dockerfile and resources)
to build or already built from registries (private or public).

Nota: Os downloads de pacotes QGIS Debian-Ubuntu precisam de uma chave de autenticagdo gpg valida. Favor
consultar as paginas de instalacdo para atualizar o seguinte arquivo Docker.

8.1 Imagens simples do estivador

As the docker image does not exist in a public registry. you will need to build it. To do so create a directory
ggis-server and within its directory:

e create a file Dockerfile with this content:

FROM debian:bookworm-slim

ENV [LANG=en_EN.UTF-8

RUN apt-get update \
&& apt—-get install --no-install-recommends —--no-install-suggests --allow-
—unauthenticated -y \
gnupg \
ca-certificates \
wget \
locales \

(continua na proxima pagina)
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&& localedef -i en_US —-f UTF-8 en_US.UTF-8 \

# Add the current key for package downloading

# Please refer to QGIS install documentation (https://www.ggis.org/fr/site/
—forusers/alldownloads.html#debian-ubuntu)

&& mkdir -m755 -p /etc/apt/keyrings \

&& wget -0 /etc/apt/keyrings/qgis—archive-keyring.gpg https://download.qgis.
—org/downloads/qgis—archive-keyring.gpg \

# Add repository for latest version of ggis—-server

# Please refer to QGIS repositories documentation if you want other version.
— (https://ggis.org/resources/installation-guide/#repositories)

&& echo "deb [signed-by=/etc/apt/keyrings/qgis—archive-keyring.gpg] https://

—qggis.org/debian bookworm main" | tee /etc/apt/sources.list.d/qgis.list \
&& apt—-get update \
&& apt-get install --no-install-recommends —--no-install-suggests —--allow-

<unauthenticated -y \

gqgis—-server \
spawn-fcgi \
xauth \
xvib \

&& apt—-get remove —--purge -y \
gnupg \
wget \

&& rm -rf /var/lib/apt/lists/*

RUN useradd -m ggis

ENV TINI_VERSION v0.19.0

ADD https://github.com/krallin/tini/releases/download/${TINI_VERSION}/tini /tini
RUN chmod +x /tini

ENV QGIS_PREFIX PATH /usr

ENV QGIS_SERVER_LOG_STDERR 1

ENV QGIS_SERVER LOG_LEVEL 2

COPY cmd.sh /home/ggis/cmd.sh

RUN chmod -R 777 /home/qgis/cmd.sh

RUN chown ggis:qgis /home/qgis/cmd.sh

USER qggis
WORKDIR /home/qgis

ENTRYPOINT ["/tini", "—-"]

CMD ["/home/ggis/cmd.sh"]

e criar um arquivo cmd . sh com este conteddo:

#!/bin/bash

[[ SDEBUG == "1" ]] && env
exec /usr/bin/xvfb-run --auto-servernum --server-num=1 /usr/bin/spawn-fcgi -p 5555
—-n -d /home/qgis —-- /usr/lib/cgi-bin/qggis_mapserv.fcgi

e construir a imagem com:

[docker build -f Dockerfile -t ggis-server ./ }
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8.1.1 Primeira execucao
Para executar o servidor, vocé precisard de um arquivo de projeto QGIS. Vocé pode utilizar um dos seus ou escolher
esta amostra.

To do so, create a directory dat a within the directory ggis—server and copy your file in it. To comply with the
following explanations, rename it to osm. ggs.

Nota: You may need to add advertised URLs under the QGIS Server tab of the Project » Properties if the Get-
Capabilites are broken. For example if your server is exposed on port 8080, you will put this for advertised URL
http://localhost:8080/ggis—-server/. More information available in section Configurar seu projeto
and subsequent.

Agora, vocé pode executar o servidor com:

docker network create ggis

docker run -d —--rm —--name ggis-server —--net=qgis --hostname=ggis-server \
-v $(pwd) /data:/data:ro -p 5555:5555 \
—e "QGIS_PROJECT_FILE=/data/osm.qggs" \
ggis-server

Opgdes utilizadas:
¢ -d*: rodar em segundo plano
* —rm: remover o container quando parar
¢ —nome: nome do container a ser criado
e —net*: (anteriormente criada) sub-rede
* —hostname: nome da hostname do recipiente, para referéncia posterior
e -v: diretério de dados local a ser montado no contéiner
e **_p: mapeamento da porta

e -e*: varidvel de ambiente a ser utilizada no contéiner

Para verificar, digite docker ps | grep ggis—server e vocé deve ver uma linha com qgis-server:
CONTAINER ID IMAGE COMMAND CREATED STATUS -
<, PORTS NAMES

4de8192da76e ggis—server "/tini -- /home/ggis.." 3 seconds ago Up 2 seconds.

— 0.0.0.0:5555->5555/tcp qgis—server

8.1.2 Amostra utilizavel

As the server is only accepting fastcgi connections, you need an HTTP server that handles this protocol. To do so we
have to create a simple Nginx configuration file and start a Nginx image.

Criar um arquivo nginx . conf no diretdrio atual com este contetido:

server {

listen 80;

server_name _;

location / {
root /usr/share/nginx/html;
index index.html index.htm;

}

location /ggis-server {
proxy_buffers 16 16k;

(continua na proxima pagina)
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proxy_buffer_size 16k;
gzip 7
include fastcgi_params;
fastcgi_pass ggis—-server:5555;

E digite este comando:

docker run -d —--rm —-—name nginx —-net=qggis —--hostname=nginx \
-v $(pwd) /nginx.conf:/etc/nginx/conf.d/default.conf:ro —-p 8080:80 \
nginx:1.13

To check capabilities availability, type in a browser http://localhost:8080/qgis-server/?SERVICE=WMS&
VERSION=1.3.0&REQUEST=GetCapabilities

8.1.3 Limpeza

Para limpar as imagens em execucdo, digite:

[docker stop ggis—-server nginx

8.2 Pilhas de docas

O método anterior é ficil de ser roteirizado, mas ndo pode ser facilmente compactado, nem padronizado ou facilmente
administrado.

To work with a docker image set you could use a docker stack managed by an orchestrator. In a stack, the images are
working in the same private network, and you can start / stop the whole stack or deploy the stack to other workers.
There are many orchestrators, for example Swarm, Kubernetes and Mesos.

A seguir, apresentaremos configura¢oes simples para fins de teste. Elas nio sdo adequadas para produgio.

8.2.1 Enxame/doca-composicao

Docker now has its own orchestrator: Swarm (compatible with docker-compose files). You have to enable it (the
Mac version will also work with Linux).

Descricao da pilha

Agora que o Swarm estd funcionando, crie o arquivo de servigo (veja Deploy to Swarm) ggis—stack.yaml:

version: '3.7'

services:
gqgis-server:
# Should use version with utf-8 locale support:
image: ggis-server:latest
volumes:
— REPLACE_WITH_ FULL_PATH/data:/data:ro
environment:
— LANG=en_EN.UTF-8
QGIS_PROJECT_FILE=/data/osm.qgs
QGIS_SERVER_LOG_LEVEL=0 # INFO (log all requests)
— DEBUG=1 # display env before spawning QGIS Server
(continua na préxima pagina)
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nginx:
image: nginx:1.13
ports:
- 8080:80
volumes:
— REPLACE_WITH_FULL_PATH/nginx.conf:/etc/nginx/conf.d/default.conf:ro
depends_on:
- ggis-server

Para implantar (ou atualizar) a pilha, digite:

[docker stack deploy -c ggis-stack.yaml ggis-stack

Check the stack deployment status until you obtain 1/1 in the replicas column:

[docker stack services ggis-stack

Algo parecido com:

ID NAME MODE REPLICAS —
— IMAGE PORTS

gmx7ewlvwsgt ggis_nginx replicated 1/1 o
—nginx:1.13 *:8080->80/tcp

10v2e7cl43u3 ggis_ggis-server replicated 1/1 -

—ggis-server:latest

To check WMS capabilities, type in a web browser http://localhost:8080/qgis-server/?SERVICE=WMS&
VERSION=1.3.0&REQUEST=GetCapabilities

Limpeza

Para limpeza, digite:

[docker stack rm ggis-stack

8.2.2 Kubernetes

Instalacao

If you have a Docker Desktop installation, using Kubernetes (aka k8s) is pretty straight forward: enable k8s.
If not, follow the minikube tutorial or microk8s for Ubuntu.

As Kubernetes installation can be really complex, we will only focus on aspects used by this demo. For further /
deeper information, check the official documentation.
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microk8s

microk8s needs extra steps: you have to enable the registry and tag the qgis-server image in order to have Kubernetes

to find the created images.

Primeiro, habilite o registro:

[microk8s enable dashboard dns registry

Em seguida, etiquete e passe a imagem para seu registro recém-criado:

—dgils—server

docker tag ggis-server 127.0.0.1:32000/ggis-server && docker push 127.0.0.1:32000/

|

Finally, add or complete the /et c/docker/daemon. json to have your registry 127.0.0.1:32000 listed in the

insecure-registries field:

{

"insecure-registries": ["127.0.0.1:32000"]

Criando manifestos

Kubernetes describes the objects to deploy in yaml manifests. There are many different kinds, but we will only
use deployments (handle pods, i.e. docker images) and services to expose the deployments to internal or external

purposes.

Manifestacoes de implantacao

Criar um arquivo :arquivo: deployments.yaml” com este contetido:

apiVersion: apps/vl
kind: Deployment
metadata:
name: ggis—-server
namespace: default
spec:
replicas: 1
selector:
matchLabels:
myLabel: ggis-server
template:
metadata:
labels:
myLabel: ggis-server
spec:
containers:
- name: ggis-server
image: localhost:32000/ggis—server:latest
imagePullPolicy: Always
env:
— name: LANG
value: en_EN.UTF-8
— name: QGIS_PROJECT_FILE
value: /data/osm.qgs
- name: QGIS_SERVER_LOG_LEVEL

value: "O"
— name: DEBUG
value: "1"

(continua na préxima pagina)
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ports:
— containerPort: 5555
volumeMounts:
- name: ggis-data
mountPath: /data/

volumes:
- name: ggis-data
hostPath:

path: REPLACE_WITH_FULL_PATH/data

apiVersion: apps/vl
kind: Deployment
metadata:
name: ggis-nginx
namespace: default
spec:
replicas: 1
selector:
matchLabels:
myLabel: ggis-nginx
template:
metadata:
labels:
myLabel: ggis-nginx
spec:
containers:

- name: ggis—nginx
image: nginx:1.13
ports:

— containerPort: 80
volumeMounts:
- name: nginx-conf
mountPath: /etc/nginx/conf.d/

volumes:
- name: nginx-conf
configMap:

name: nginx-configuration

kind: ConfigMap
apiVersion: vl
metadata:
name: nginx-configuration
data:
nginx.conf: |
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Manifestos de servico

Criar um arquivo :arquivo: services.yaml™ com este contetido:

apiVersion: vl
kind: Service
metadata:
name: ggis-server
namespace: default

spec:
type: ClusterIP
selector:
myLabel: ggis-server
ports:

— port: 5555
targetPort: 5555
apiVersion: vl
kind: Service
metadata:
name: ggis-nginx
namespace: default

spec:
type: NodePort
selector:
myLabel: ggis-nginx
ports:

— port: 80
targetPort: 80
nodePort: 30080

Implantacao de manifestos

Para implantar as imagens e servigos em Kubernetes, pode-se usar o painel de controle (clique no +* no canto superior
direito) ou a linha de comando.

Nota: When using the command line with microk8s you will have to prefix each command with microk8s.

Para implantar ou atualizar seus manifestos:

[kubectl apply —-f ./ }

Para verificar o que est4 atualmente implantado:

[kubectl get pods, services,deployment }

Vocé deveria obter algo como:

NAME READY STATUS RESTARTS AGE
pod/ggis—nginx-54845ff6f6-8skp9 1/1 Running 0 27m
pod/qggis-server-75df8ddd89-c7t7s 1/1 Running 0 27m

NAME TYPE CLUSTER-IP EXTERNAL-IP PORT (S) -
— AGE

service/Kubernetes ClusterlIP 10.152.183.1 <none> 443/TCP -
— 5h51m

service/qgis—exec-server ClusterIP 10.152.183.218 <none> 5555/TCP o
— 35m

service/ggis—nginx NodePort 10.152.183.234 <none> 80:30080/TCP._

(continua na préxima pagina)
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— 27m

service/ggis—server ClusterIP
NAME READY
deployment .apps/ggis—nginx 1/1

deployment .apps/qgis-server 1/1

10.152.183.132 <none>

UP-TO-DATE
1
1

AVAILABLE
1
1

(continuac@o da pégina anterior)

AGE
27m
27m

5555/TCP

Para ler os logs nginx/qgis, digite:

[kubectl logs —-f POD_NAME

)

To check WMS capabilities, type in a web browser http://localhost:30080/qgis-server/?SERVICE=WMS&

VERSION=1.3.0&REQUEST=GetCapabilities

Limpeza

Para limpar, digite:

kubectl delete service/qgis—-server service/ggis-nginx deployment/ggis-nginx.
—deployment/ggis-server configmap/nginx-configuration

8.3 Implantacao de nuvens

Managing your own cluster of servers to handle the deployment of containerized applications, is a complex job. You
have to handle multiple issues, such as hardware, bandwidth and security at different levels.

Cloud deployment solutions can be a good alternative when you do not want to focus on infrastructure management.

A cloud deployment may use proprietary mechanisms, but they are also compatible with the stages explained previ-

ously (docker images and stack management).

8.3.1 AWS usecase

With Amazon AWS, through ECS (Elastic Container Service) functionalities, you can use docker-compose or Kuber-
netes compatible wrappers to manage your stack. You will have to create an image registry for your custom images

to be accessible.

To use docker-compose alike functionalities, you need to install the ecs-cli client and have proper permissions / roles.
Then, with the help of the ecs-cli compose commands, you can reuse the stack description.

To use Kubernetes, you can use the AWS web console or the command line tool eksctl and have the proper permissions
/ roles. Then with a well configured kubectl environment, you can reuse the Kubernetes manifests.

8.3. Implantacao de nuvens
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Perguntas mais frequentes

* Quais sdo as diferengas entre o QGIS Desktop e o Servidor QGIS?

QGIS Desktop has a graphical user interface and allows you to create and modify maps. QGIS Server is a
server application serving your QGIS project files to end user applications via OGC web services like WMS,
WES, etc..

e What is OGC?

The OGC (Open Geospatial Consortium) is an international not for profit organization committed to making
quality open standards for the global geospatial community.

* Name some other web mapping servers?
ArcGIS server, Geoserver, Mapserver, Mapnik etc.

* How to compare QGIS server to other web mapping servers? (2021/01/01)

Feicoes Servidor QGIS GeoServer Servidor ArcGIS
Desde 2006 2001 1999
Licenca GPL GPL comercial
Suporte comercial Multiple companies Multiple com- ESRI and its ven-
panies dors network
Tecnologia C++/python Java C++
Tile cache sim yes (via Ge- sim
oWebCache)
3D Nio Nio Sim
Consultas FES (2.0)and OGC (1.0) fil- CQL and OGC OGC filters
ters filters
Report generation sim sim sim
Administracio do servidor yes via third parties web + API web+ APIREST
(LizMap, QWC2, etc.) REST
Edigéo de camada/simbologia complete via dedicated GUI ~ simple via web complete via dedi-
do projeto GIS interface cated GUI

» What are the OGC specification versions implemented in QGIS server compared to other web mapping servers?

(2021/01001)

119


https://www.ogc.org/publications
https://www.ogc.org/publications
https://www.ogc.org/

QGIS Server 3.40 User Guide

OGC standards Servidor QGIS GeoServer  Servidor ArcGIS
WMS (Web Map Service) 1.3.0-1.1.1 1.3.0-1.1.1 1.3.0-1.1.1
SRW (Servigo de Recursos da Web) 1.1.0- 1.0.0 2.0.0-1.00 2.0.0-1.0.0
OAPIF (aka WFS3) 1.0.0 ndo nao

WMTS (Web Map Tile Service) 1.0.0 1.0.0 1.0.0

WCS (Web Coverage Service) 1.0.0 2.0.1-1.00 20.1-1.00
WPS (Web Processing Service) ndo 1.0.0 1.0.0

SCW (Servico de Catalogo para a Web) nio 2.0.2 ndo

SLD (Styled Layer Descriptor) sim sim sim

e What is a tile cache?

Maps are often static. As most mapping clients render WMS (Web Map Service) data every time they are
queried, this can result in unnecessary processing and increased wait times.

The tile cache optimizes this experience by saving (caching) map images, or tiles, as they are requested, in
effect acting as a proxy between client (such as OpenLayers or Google Maps) and server (any WMS-compliant
server). As new maps and tiles are requested, QGIS server intercepts these calls and returns pre-rendered tiles
if stored, or calls the QGIS engine to render new tiles as necessary. Thus, once tiles are stored, the speed of
map rendering increases by many times, creating a much improved user experience.

What is PostgreSQL?

PostgreSQL <https://www.postgresql.org/>"_ € um poderoso e de cddigo aberto companheiro de banco de
dados objeto-relacional para QGIS.

O que é PostGIS?

PostGIS is a spatial database extender for PostgreSQL object-relational database. It adds support for geographic
objects allowing location queries to be run in SQL.
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